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COPYRIGHT 
 

© Copyright 1998-2010.  This document contains materials protected by International Copyright 
Laws. All rights reserved. No part of this manual may be reproduced, transmitted or transcribed in any 
form and for any purpose without the express written permission of QueTek® Consulting 
Corporation. 
 
 
TRADEMARKS 
 

Companies and products mentioned in this manual are for identification purpose only.  Product 
names or brand names appearing in this manual may or may not be registered trademarks or 
copyrights of their respective companies. 
 
 
NOTICE 
 

Reasonable effort has been made to ensure that the information in this manual is accurate. 
QueTek® Consulting Corporation assumes no liability for technical inaccuracies, typographical, or 
other errors contained herein. 

 
QueTek® Consulting Corporation provides this manual “as is” without warranty of any kind, 

either express or implied, including, but not limited to the implied warranties or conditions of 
merchantability or fitness for a particular purpose. In no event shall QueTek® Consulting Corporation 
be liable for any loss of profits, or for direct, indirect, special, incidental or consequential damages 
arising from any defect or error in QueTek® Consulting Corporation’s products or manuals. 

 
Information in this manual is subject to change without notice and does not represent a commitment 
on the part of QueTek® Consulting Corporation. 
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LICENSE AGREEMENT AND LIMITED WARRANTY 
 
READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY PRIOR TO PURCHASING 
THE LICENSE CODE TO UNLOCK FILE SCAVENGER®. THIS DOCUMENT IS AN 
AGREEMENT BETWEEN YOU (THE “LICENSEE”) AND QUETEK® CONSULTING 
CORPORATION (THE “COMPANY”). IF YOU DO NOT AGREE WITH ANY OF THE 
FOLLOWING TERMS AND CONDITIONS, DO NOT PURCHASE THIS PRODUCT. 
 
1. GRANT OF LICENSE: This agreement between QueTek® Consulting Corporation (hereinafter the 
“COMPANY”) and you (hereinafter the “LICENSEE”) permits you the non-exclusive right to use File 
Scavenger® (hereinafter the “SOFTWARE”). Depending on the type of license you have purchased, 
your rights to use the SOFTWARE are as follows: 
 
a) If you have purchased a Personal Use license, you are granted the right to use the SOFTWARE on a 
single Windows® computer. You can transfer this license to a second computer provided that i) the 
SOFTWARE is completely removed from the original computer and ii) you no longer intend to use 
the SOFTWARE on the original computer. The right to transfer a license is not meant for the license 
to be used as a floating license among multiple computers. 
 
b) If you have purchased a Professional Use license and your name has been registered as the licensee, 
you are granted the right to use the SOFTWARE on any computer. You can transfer the license to 
another licensee provided that you no longer intent to use the SOFTWARE because of a permanent 
change in job assignments or other similar circumstances. The right to transfer a license is not meant 
for the license to be shared among multiple users. 
 
2. OWNERSHIP OF SOFTWARE: You are granted the right to use a copy of the SOFTWARE. The 
COMPANY retains all the rights, title and ownership to the SOFTWARE. 
 
3. RESTRICTIONS OF USE: You may not reverse engineer, disassemble, decompile or create 
derivative work based on this SOFTWARE without explicit written permissions from the 
COMPANY. 
 
4. LIMITED WARRANTY: The LICENSEE agrees to use the SOFTWARE at the LICENSEE'S own 
risk. To the fullest extent of applicable laws and regulations, the COMPANY does not warrant that the 
SOFTWARE will meet the LICENSEE'S requirements or that the SOFTWARE is free of defects. 
 
5. NO LIABILITY FOR DATA INTEGRITY: The COMPANY does not warrant that any files 
recovered by the SOFTWARE will preserve the original contents. The LICENSEE has the 
responsibility to validate, by other means, that the contents of any recovered files are intact and usable 
for the LICENSEE'S purposes. 
 
6. NO WARRANTY OF FUTURE UPDATES: The COMPANY does not warrant that the 
SOFTWARE will continue to operate and be supported in future versions of the operating systems the 
SOFTWARE operates under. 
 
7. TECHNICAL SUPPORT: The LICENSEE is entitled to technical support via electronic mail for 1 
year from the date of purchase, except for Professional Use licensees who receive 3 years of technical 
support. Under normal conditions, the LICENSEE will receive a response to a question within two 
business days.  
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IN NO EVENT SHALL THE COMPANY OR ITS EMPLOYEES, AGENTS, SUPPLIERS, OR 
CONTRACTORS BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL, OR 
CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE SOFTWARE. THESE 
INCLUDE, BUT NOT LIMITED TO, LOSS OF USE, LOSS OF DATA, LOSS OF PROFIT, LOSS 
OF BUSINESS OPPORTUNITIES, LOSS OR DAMAGES TO PROPERTY, INJURIES TO ANY 
PERSON, EVEN IF THE COMPANY HAS BEEN ADVISED ON THE POSSIBILITY OF SUCH 
LOSSES OR DAMAGES.THE ABOVE LIMITATIONS MAY NOT APPLY IN SOME 
JURISDICTIONS THAT DO NOT ALLOW SUCH LIMITATIONS OF LIABILITY. 



 

User Guide - 5

 

Overview: 
What is in this manual? 

 
 

Section I: Introduction 
Chapter 1, “Introduction to File Scavenger®,” helps you determine whether this is the right tool for 
you. 
 

Section II: Recovery Procedures 
Chapter 2, “Data or System Drive? ,” helps you determine whether to proceed to Chapter 3 or 4. 
 
Chapter 3, “Recovering Files from a Data Drive,” presents the best procedure to recover data from a 
data drive. 
 
Chapter 4, “Recovering Files from a System Drive,” presents the best procedures to recover data from 
a system drive. 
 

Section III: Using File Scavenger 
Chapter 5, “Installing File Scavenger®,” details the installation process. 
 
Chapter 6, “Using File Scavenger®,” discusses how to use File Scavenger®. 
 
Chapter7, “Using Other File Scavenger® Features,” discusses infrequently-used File Scavenger® 
features. 
 
Chapter 8, “Features,” explains in detail the features of File Scavenger®. 
 
Chapter 9, “Dialogs,” describes all program dialogs. 
 
Chapter 10, “Menus,” describes all program menus. 
 
Chapter 11, “FAT and FAT32 Partitions,” discusses the weaknesses of the FAT and FAT32 file 
systems. 
 
Chapter 12, “Troubleshooting Guide,” describes how to solve common problems you may encounter. 
 

Section IV: RAID and Spanned Volumes 
Chapter 13, “Overview of RAID Reconstruction,” provides a high-level view of the RAID 
reconstruction process. 
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Chapter 14, “Common Causes of RAID Failure,” describes the most common causes of RAID failure. 
 
Chapter 15, “Overview of Hardware RAID Reconstruction,” provides a high-level view of the 
reconstruction process for hardware-based RAID. 
 
Chapter 16, “Reconstruction Procedure for Hardware RAID,” discusses in detail the reconstruction 
procedure for hardware-based RAID. 
 
Chapter 17, “Overview of Software RAID Reconstruction,” provides a high-level view of the 
reconstruction process for software-based RAID. 
 
Chapter 18, “Reconstruction Procedure for Software RAID,” discusses in detail the reconstruction 
procedure for software-based RAID. 
 
Chapter 19, “RAID Settings,” discusses the necessity of knowing the correct RAID settings for 
successful recovery. 
 
Chapter 20, “RAID Recovery Services,” discusses the services we provide to help you recover data 
from a failed RAID. 
 
Chapter 21, “Overview of Spanned Volume Reconstruction,” gives you a broad picture of spanned 
volume reconstruction. 
 
Chapter 22, “Spanned Volume Reconstruction Procedure,” discusses spanned volume recovery in 
detail. 
 
Appendix A, “Contact and Technical Support,” lists contact information for sales and technical 
support. 
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Section I: Introduction 

Chapter 1: 
Introduction to File Scavenger® 

 
 

A successful recovery usually depends on the nature of data loss and actions already taken 
before using File Scavenger®. After reading this chapter, continue with Chapters 2, 3 and 4 
before proceeding. 
 
For brevity, the drive containing the lost data is henceforth called the “subject drive.” 

Is Data Recoverable? 
The guidelines below are applicable to the NTFS file system, which is highly recoverable and 
the default file system for hard drives on computers running Windows® 7, Vista, XP, 2008, 
2003, 2000, and NT 4. The older FAT and FAT32 file systems are poorly recoverable and are 
the default file systems for small portable storage devices such as memory sticks, SD cards, 
etc. The FAT and FAT32 file systems are also used on the now-obsolete Windows® 95, 98 
and Me platforms. Please see “Chapter 11: FAT and FAT32 Partitions” for more information. 
 
The following scenarios are highly recoverable: 

• Formatting or deleting a partition. 
• Unsuccessful merging of two partitions. 
• A drive becoming corrupted and inaccessible but still being detected by the computer 

BIOS. 
• Accidental deletion of files, including deletion from the Windows® Recycle Bin, 

provided that immediate actions are taken. 
 
The following scenarios are partially recoverable: 

• Restoring Windows® from a recovery CD. The original data on the boot drive will 
be partially overwritten by files copied from the CD. The percentage of recoverable 
files is higher for a larger boot partition. For example, it could be between 50% and 
80% for a 40-GB partition. 

• Accidental deletion of files many days before and the computer has been in use since 
then. 

 
The following scenarios are poorly recoverable or unrecoverable: 

• Restoring a disk image (such as Ghost image) on a wrong drive. The original data on 
the drive is usually overwritten and unrecoverable. 

• A large amount of new data has been created or copied on the subject drive since the 
data loss incident occurred. 

• A file has been edited and saved. The original version is usually not recoverable. 
 

If a drive is physically faulty and is no longer detected by the computer BIOS or cannot be 
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accessed reliably, the drive may require physical repair. Almost all faulty drives can be 
repaired but the costs can easily be as high as a few thousand dollars. 

Is File Scavenger® the Right Tool? 
 

File Scavenger® is a powerful and user-friendly data recovery tool for Windows® computers. 
Files can be recovered in case of: 
 
• Accidental deletion. 
• Removal from the Windows® Recycle Bin. 
• Reformatting or deletion of partitions. 
• Corrupt partitions. 
• Partially failed hard drives with bad media spots. 
• Failed RAIDs. 
• Failed spanned volumes. 

 
File Scavenger® can recover the original filename, folder path and dates. It can recover entire 
folders or, in the case of corrupt, deleted or reformatted partitions, entire partitions. File 
recovery is a copying operation. File Scavenger® gathers information on the subject drive to 
reconstruct the lost files and copy them to a destination drive.  
 
File Scavenger® can be downloaded and purchased through our website below: 
 
http://www.quetek.com/prod02.htm 
 
File Scavenger® cannot recover data if the disk hardware has failed completely, such as when 
the disk does not spin up or is not recognized by the PC hardware BIOS. 
 
File Scavenger® is compatible with all Windows® platforms. However, recovery on the 
95/98/ME platforms is limited due to the inherent weaknesses of the FAT and FAT32 file 
systems used on those platforms. See “Chapter 11: FAT and FAT32 Partitions” for more 
information. 
 
Details about all File Scavenger® features can be found in “Chapter 8: Features.” 

http://www.quetek.com/prod02.htm�
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Section II: Recovery Procedures 

Chapter 2: 
Data or System Drive? 

 
 

Successful recovery depends on whether the lost data still exists on the subject drive. When a 
file is deleted or a partition is formatted, data becomes inaccessible but still exists on disk and 
is recoverable using File Scavenger®. However, if the disk area occupied by a lost file has 
been written over by new data, the file cannot be recovered. 
Therefore you must “write-protect” the subject drive. 
 
Knowing whether the subject drive is a system or data drive will help you determine the most 
effective recovery procedure. Read this chapter and then proceed to “Chapter 3: Recovering 
Files from a Data Drive” or “Chapter 4: Recovering Files from a System Drive.”    
 
A system drive is more difficult to recover from. When a computer is active, Windows® 
frequently updates the system drive, potentially overwriting any lost data. A data drive is less 
volatile and is not changed as long as the programs residing on it are inactive. 
 
On a typical Windows® computer, drive C is the system drive and other drives are data 
drives. Note that My Documents, Desktop, etc. are folders, not drives. 
 
On a computer with an advanced or custom configuration, a system drive is one used by 
Windows® for its internal operations and may contain any of the following:  

• A system folder such as Windows, Desktop, Documents and Settings, My 
Documents, etc.  

• The Windows® TEMP folder used for temporary storage.  
• The cache folder used by an Internet browser such as Internet Explorer to save 

information from recently visited web pages.  
• System page files. 

There can be many system drives. For example, drive C may contain the Windows folder and 
drive D a page file. 
 
If a drive is not a system drive, it is a data drive, containing only user programs and data.  
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Figure 2.1: Screen capture of Windows  
Explorer showing the active Windows® folder on drive C. 
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Figure 2.2: The TEMP and TMP folders are on drive C in this example.  
(In Control Panel click System and Security, System, Advanced system settings, 

Environment Variables.) 



  

 
User Guide - 12 

 
 
 
 

 

Figure 2.3: The page files are on drives C and F in this example  
(In Control Panel click System and Security, System, Advanced system settings, 

Performance, Settings, Advanced, Virtual Memory, Changes.) 
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Figure 2.4: Internet Explorer’s cache folder is on drive C in this example.  
(In Internet Explorer click Tools, Internet Options, Browsing History Settings.) 
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Chapter 3: 
Recovering Files from a Data Drive 

 
 

Warning: The procedures below are effective for a data drive. (See “Chapter 2: Data or 
System Drive?”) For system drives, see “Chapter 4: Recovering Files from a System Drive.” 
 
As mentioned in the previous chapter, a data drive holds only user programs and data. The 
drive is not changed as long as the programs residing on it are inactive.  
 
The recovery procedure for a data drive consists of six steps: 
 

1. Protect the subject drive.  
2. Install File Scavenger®.  
3. Search for files. 
4. Activate File Scavenger®. 
5. Recover files to a destination folder. 
6. Validate the recovered files. 

Step 1: Protect the Subject Drive 
Immediately write-protect the subject drive to ensure no new data is written to it. New data 
may overwrite the lost data. Once overwritten data cannot be recovered. 
 
The procedure is as follows:  

• Stop programs on this computer that may write to the drive. For example if the drive 
holds SQL databases, SQL programs must be stopped. In another example, if your 
email program is on the drive, stop using email. 

• Disable all shared folders on the drive to prevent other computers from writing new 
data to them.  

• If you need to reboot the computer, make sure the Windows® Scan Disk (or Check 
Disk) utility is not run. If Windows® decides the drive needs to be repaired, it will 
ask for your permission to run this utility. You must choose “No” because Scan Disk 
can further compound the problem. 
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Figure 3.1: Recover is a shared network folder on the computer QTDEV20. 
 
After write-protecting the subject drive, you can optionally choose to create a disk image of 
the drive as a backup. This will help in case the drive fails or becomes further degraded. This 
operation will require a new drive larger than the subject drive and may take many hours to 
complete. See “Disk Image File” in Chapter 7 for more information. 
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Step 2: Install File Scavenger® 
You can follow any installation procedure in “Chapter 5: Installing File Scavenger®” as long 
as File Scavenger® is not installed on the subject drive. 

Step 3: Search for Files 
See “Chapter 6: Using File Scavenger.” 

Step 4: Activate File Scavenger® 
See “Purchasing a License” in Chapter 6. 

Step 5: Recover Files to a Destination Folder 
See “Destination Folder” in Chapter 6. 

Step 6: Validate Recovered Data 
Sometimes files are recovered with the correct size and filename but are unusable because the 
contents are corrupt. If that is caused by actual corruption on the drive, nothing can be done. 
However, the optimal recovery procedure may not have been followed. 
 

Before reusing the subject drive, make sure all data has been recovered. Validate recovered files by 
opening them in their respective programs. Keep the subject drive for a few weeks just in case it is 
needed again for recovery. 
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Chapter 4: 
Recovering Files from a System Drive 

 
 

Warning: The procedures below are effective for a system drive. (See “Chapter 2: Data or 
System Drive?”) For data drives see “Chapter 3: Recovering Files from a Data Drive.” 
 
When the lost data was on a system drive, you face a dilemma. The computer must be active 
for recovery. But as soon as Windows® is started, it will create new data on the system drive, 
potentially overwriting the lost data. Overwritten data cannot be recovered. 

Safe Procedures 
The safest procedure is to change the subject drive into a data drive using the procedures 
below. Then follow the procedure in “Chapter 3: Recovering Files from a Data Drive.” The 
procedures require a second computer or a new hard drive and familiarity with hardware and 
software installation. If time and resources are limited, the “Quick Procedure” in the next 
section is more practical but will reduce the chance of a successful recovery. 
 
If a second computer is available: 

• Immediately shutdown the computer holding the lost data. 
• Remove the subject drive and mount it on the second computer as a data drive. Do 

not let Windows® Scan Disk or Check Disk repair the drive when booting up the 
computer.  

 
If the subject drive is a laptop drive and the second computer is a desktop computer, you can 
purchase a hard drive enclosure for laptop drives with a USB connection. You can also 
purchase a laptop hard drive adapter to connect a laptop drive to an IDE cable. They are 
usually sold for under $20. 
 
If a second computer is not available: 

• Immediately shutdown the computer holding the lost data. 
• Remove the subject drive to avoid accidental change during the next steps. 
• Install a new hard drive. Install Windows® (7, Vista, XP, 2008, 2003 or 2000) and 

File Scavenger® on it.  
• Reconnect the subject drive, now as a data drive. Do not let Windows® Scan Disk or 

Check Disk repair the drive when booting up the computer  

Quick Procedure 
Follow this procedure only if you cannot use the “Safe Procedures” discussed earlier in this 
chapter due to lack of resources or time. This procedure does not completely write-protect the 
subject drive and, therefore, may reduce the chance of a successful recovery. However, if you 
carefully follow the procedure, the reduction is minor. 
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The quick recovery procedure for a system drive consists of six steps: 
 

1. Protect the subject drive.  
2. Install File Scavenger®.  
3. Search for files. 
4. Activate File Scavenger®. 
5. Recover files to a destination folder. 
6. Validate the recovered files. 

Step 1: Protect the Subject Drive 
You must stop all activities that may write new data to the subject drive, as follows:  

• Go to Control Panel, System and Security, Windows Update and turn 
automatic updating off. This service can potentially download a large amount of 
data on the system drive. 

• Stop using the computer for any activities other than data recovery. Email and 
Internet browsing activities must be strictly avoided.  

• Stop all background programs such as instant messaging, backup, virus 
protection, local drive search engines, etc.  

• Do not download or install any software including File Scavenger®. The system 
drive will be indirectly used even if you specify another drive for downloading 
or installing. 

• Disable all network shared folders.  
• Do not burn CDs or DVDs. The system drive will be used indirectly when a CD 

or DVD is created. 

Step 2: Install File Scavenger® 
• If you have a File Scavenger® CD, follow “Running File Scavenger® from a CD.” 

in Chapter 5. 
• If you do not have a File Scavenger® CD but have a second Windows® computer, 

follow “Indirect Installation” in Chapter 5. 
• If you have neither of the above, you can follow “Running File Scavenger® from 

www.quetek.com” in Chapter 5 but your chance of success is slightly reduced. 
• If none of the above is possible, you can follow “Direct Installation” in Chapter 5 but 

your chance of success is significantly reduced. 

Step 3: Search for Files 
See “Chapter 6: Using File Scavenger.” 

Step 4: Activate File Scavenger® 
See  “Purchasing a License” in Chapter 6. 

Step 5: Recover Files to a Destination Folder 
See “Destination Folder” in Chapter 6. 

http://“Running File Scavenger® from www.quetek.com”�
http://“Running File Scavenger® from www.quetek.com”�
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Step 6: Validate Recovered Data 
See “Step 6: Validate Recovered Data” in Chapter 3 
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Chapter 5: 
Installing File Scavenger® 

 
 

When recovering files from a system drive (see “Chapter 2: Data or System Drive?”), 
downloading and installing File Scavenger® directly on the subject computer will reduce 
your chances of success. See “The risk of direct installation” in this chapter for a quantitative 
analysis. You should run File Scavenger® from a CD or follow the “Indirect Installation” 
procedure discussed in this chapter. 

When recovering files from a data drive, all installation procedures are safe as long as the 
installation folder is not on the drive. 

Requirements: 

• Microsoft Windows® 7, Vista, XP, 2008, 2003, 2000 or NT. 
• 64 MB of RAM. 
• 2 MB of free disk space for installation. 

 

Running File Scavenger® from a CD 
Running the program directly from a File Scavenger® CD is the most convenient and safest 
procedure. 
 

• Insert a File Scavenger® CD into the CD drive. 
• Double click on FileScav.exe. 
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Figure 5.1: Double-click on FileScav to start the program. 

Indirect Installation 
The indirect installation procedure does not create new data on the subject computer to avoid 
overwriting the lost data. 

• On another computer, download and save the program file from our web site onto a 
portable storage device such as a memory stick, USB drive, etc. 
http://www.quetek.com/bin/filescav.exe 

 
• Mount the removable storage device on the subject computer.  
• Use Windows Explorer to browse to the drive letter assigned to the device and double-

click on filescav.exe to start File Scavenger®. 

http://www.quetek.com/bin/filescav.exe�
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Running File Scavenger® from www.quetek.com 
Under this procedure, the File Scavenger® executable file is run directly from a web link.  

 
Warning: If you are recovering files from a system drive (see “Chapter 2: Data or System 
Drive?”), this procedure will slightly reduce the chance of success.  

This procedure creates only a few files on the boot drive, much fewer than a direct installation 
(see “Direct Installation” later in this chapter). Under this procedure, online Help information 
is not available.  

• In Windows® XP, 2003 and 2000, click the Start button. Click Run, type the 
following link, and click OK: 

http://www.quetek.com/bin/filescav.exe 

• In Windows® 7 and Vista, click Start and type the link above in the Search box. 
• Confirm any security prompts. 

When you are ready to purchase a license, do not launch an Internet browser on the subject 
computer because the browser may create new files on the subject drive, thus reducing the 
chances of a successful recovery. Instead, click Help, Licenses, Personal-Use License to 
display the Registration Code. Write it down and use another computer to purchase a 
license. Call us (see “Appendix A: Contact & Technical Support”) to purchase a license over 
the phone if necessary. 

Direct Installation  
Under this procedure, File Scavenger® is downloaded and installed directly on the subject 
computer. 

 
Warning: If you are recovering files from a system drive (see “Chapter 2: Data or System 
Drive?”), a direct installation will reduce the chances of success. See “The risk of direct 
installation” later in this chapter for a quantitative analysis. 
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Installation from www.quetek.com 
• Visit http://www.quetek.com/download.htm 
• Click on the download button for direct installation on a hard drive. 
• Follow instructions to complete the installation. 

 

 
 

Figure 5.2: Click Run to download and install File Scavenger®. 
 

 
 

Figure 5.3: Download in progress. 

http://www.quetek.com/download.htm�
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Installation process 
 

 
 

Figure 5.4: Click OK to continue. 
 
 

 
 

Figure 5.5: Click Next to continue. 
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Figure 5.6: Accept the license agreement. 

 
 

 
Figure 5.7: Click Next to accept the default installation folder or click Browse to 

change it. 
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Figure 5.8: Click Next to accept the default Start Menu folder or  

click Browse to change it, and choose the access mode Everyone or Just me. 
 
 

 
Figure 5.9: Review the installation and start up folders.  

Click Back to make any necessary change.  Click Install to continue. 
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Figure 5.10: Click Finish to complete the installation and launch the program. 

The risk of direct installation 
If the subject drive is a system drive, downloading and installing File Scavenger® on the 
subject computer will reduce your chances of a successful recovery. This section will 
quantify the risk. 
 
If the subject drive is a data drive, direct installation is safe (as long as the installation 
folder is not on the subject drive) and this discussion does not apply. 
 
A drive (usually referred to by a letter such as C, D, etc.) is the basic unit of storage with 
real physical boundaries. A folder is a logical container of files with little significance 
with regard to file recovery. All files and folders on a drive share the same pool of 
storage allocation units. 
 
When a file is deleted, its “file slot” is marked as unused, but the file’s contents are not 
immediately destroyed. The file can be recovered until the slot is reallocated to a new file 
(or the expansion of an existing file). Any action that creates new data on the subject 
drive, therefore, can potentially overwrite a lost file permanently. 
 
Depending on the pattern of use on a drive, the number of unused slots varies from a few 
to several thousand or even more. A newly-formatted drive starts out with very few 
unused slots. Over time, the number usually increases. A typical drive may have several 
thousand unused slots.  
 
A browser such as Internet Explorer usually creates many new files when a web page is 
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displayed. For example, visiting Google News creates about 20 to 30 files. When you 
visit our web site to download File Scavenger®, about 50 to 100 new files are created. 
Running the File Scavenger® setup creates about 20 more files. 
 
Therefore, if you use the program Internet Explorer to download and install File 
Scavenger® from our web site, you may create a few hundred new files. Most files are 
created in the folder Temporary Internet Files, about 10 to 20 in the folder TEMP and 
about 10 in the folder you choose for File Scavenger® installation. See “Chapter 2: Data 
or System Drive?” for information about these folders. 
 
Assume you are recovering one file from drive C, which has 3,000 unused file slots. 
Assume that 300 new files are created as you download and install File Scavenger®. The 
probability for the slot occupied by the lost file to be reallocated and overwritten is 10%. 
Therefore, the installation reduces your chances of success by 10% on top of other 
factors. 
 
You can see that if the drive has 300 or fewer unused slots, the installation will certainly 
overwrite the lost file. 
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Chapter 6: 
Using File Scavenger 

 
 

On Windows® 7, Vista, XP, 2008, 2003, 2000 and NT, you must have Administrator 
privilege to run File Scavenger®. 

Searching for Files 
File Scavenger® is very simple to use. First click on the arrow at the right end of the Look In 
box and select a drive. Then select a search mode and click Search. 

 

 
Figure 6.1: Select a drive letter or disk number. 

 
The default Search for value “*” should be used to search for all types of files. If you know 
the exact types of files, click on the arrow to the right and select the desired types. See “Main 
Dialog” in Chapter 9 for more information. 
 
Usually you should select a drive letter such as drive C. However, if a partition has been 
deleted, moved or otherwise modified, selecting the disk number (Disk 0 in the figure below) 
that contains the drive letter may produce better results.  
 

 
Figure 6.2: Windows Disk Management shows C as a drive on Disk 0. 

 
Note that My Documents and Desktop are not drives but folders, usually located on drive C. 



  

 
User Guide - 30 

Quick versus Long Search 
You should try the Quick Search first, which usually takes only a few minutes. If the 
Quick Search is not successful then you must use the Long Search, which scans every 
sector of the disk and may take several minutes to a few hours, depending on the size, 
speed and condition of the subject drive and the processor speed of the computer. 
 
The Quick Search in many cases can produce cleaner results than the Long Search. The 
latter can find more files but may also include defunct files of no interest which you later 
may have to sift through and remove. See “Search section” in Chapter 9 for more 
information. 
 
The following cases are better handled with the Quick Search: 
• Files have been accidentally deleted but the drive is otherwise intact. 
• The drive is corrupt. (It may work better to select to search the disk number instead 

of the drive letter.) 
• Files have been accidentally removed from the Recycle Bin. 
• You are reconstructing a RAID or spanned volume. 
 
The Long Search usually works better for the following problems: 
• FAT/FAT32 partitions. 
• Reformatted drives. 
• Severely corrupt drives.  

Files without the original filename 
On severely corrupt drives, files may be found without the original folder or even 
filename. When the original filename cannot be determined, a file will be named as 
follows: 
 
Unknown + sequential number + file extension. 
 
For example, the first Excel file is named “Unknown000001.xls”. 
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Recovering Data 
Files found during the search are displayed as shown in Figure 6.3. To select a file for 
recovery, click on the adjacent checkbox. Hold Shift to select a range of files. Hold Control 
to select multiple files that may be non-adjacent. 
 
To sort files by Filename, Type, Folder, Volume, Status, Size or Modified Date, click on 
the corresponding heading banner. 

 

 
Figure 6.3: Search results. 
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Click on the Tree View toolbar button to show files in a tree format to select entire folders. 
 

 
Figure 6.4: Files shown in Tree View. 
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To start the recovery process, click on Step 2: Recover. 
 

 
Figure 6.5: Seven files are to be recovered to the folder Recovery on drive C. 

  
During recovery, files are copied from the subject drive to a destination drive, which cannot 
be the same as the subject drive. A destination drive cannot be a CD or DVD drive either. If 
you have only one local hard drive, please see “Destination Folder” in this chapter. Click 
Browse to select a destination folder. 
 
Click Recover to start the recovery. Files are reconstructed in the computer memory and then 
copied to the Destination Folder. 

Purchasing a License 
After installation File Scavenger® runs in demo mode in which you can recover files smaller 
than 64 kilobytes (KB) and preview picture files smaller than 4 megabytes (MB). To recover 
larger files, click Help, Licenses to display the Licenses dialog and purchase a license to 
activate the program. 
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Figure 6.6: Choose a licensing mode. 

 
You can purchase a Personal-Use license for one specific computer. The Registration Code 
required at the time of purchase must be the one displayed on the Licenses dialog on the 
subject computer. 
 
The Professional-Use license bears the name of the purchaser and can be used to activate the 
program on any computer. However, only the purchaser is legally authorized to use the 
program. 
 
If you are recovering data from a data drive (see “Chapter 2: Data or System Drive?”), you 
can click on the Launch Internet browser button to visit our web site and purchase a 
license. If data is being recovered from a system drive, however, using the Internet browser 
will reduce your chance of success. Write down the Registration Code and log on to another 
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computer to purchase a license key. (If you are purchasing a Professional-Use license, then 
the Registration Code is not required.) 
 
You receive a credit for upgrading to the immediate next version, such as from version 2 to 
version 3. You receive no credit for upgrading from version 1 to 3, 2 to 4, etc. 

Destination Folder 
File recovery is a copying operation. Files are reconstructed in the computer memory and 
copied to the Destination Folder. During this operation the subject drive must be write-
protected so that the copying is not disrupted. Therefore, the destination folder must be 
located on another drive. 
 
If there is only one hard drive in the computer, you must create a new drive letter by mapping 
a network shared folder or installing a new drive such as a USB external drive or memory 
stick. Generally data cannot be recovered to CD or DVD drives because they require drive C 
as an intermediate staging area. 
 
If you do not have any other storage media and must recover files to the same drive, you may 
lose some or all of the lost data permanently with no chance of recovery. The risk depends on 
the amount of data being recovered compared to free disk space. For example, if the drive has 
40 GB of free space and 2 MB of data is being recovered, the risk is very low. But if you are 
recovering 1 GB of data on 2 GB of free space, much of the deleted data will be overwritten, 
resulting in corrupted recovered files. 

Performance considerations 
 

Note that the discussion below is based on hardware technology as of September 2010. 
 
For the best performance when recovering a large amount of data, the destination folder 
should be created on a newly formatted volume to minimize disk fragmentation. Additionally, 
to recover files larger than 4 GB, the volume must not be in FAT or FAT32 format because of 
the file size limit imposed by these file systems. 
 
The speed of recovery usually depends on how fast data can be copied to the destination 
folder. If the folder resides on an internal hard drive, the recovery rate is typically a few 
gigabytes a minute. Larger files can be copied at a faster rate than smaller ones. 
 
External drives attached via USB can be much slower. In many cases, the recovery rate can 
be in the range of one to a few hundred megabytes per minute, which is an order of 
magnitude slower compared to internal drives. 
 
If the destination folder resides on a network shared folder or a network attached device, the 
rate of recovery usually falls in between the internal and external drives. 
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Chapter 7: 
Using Other File Scavenger® Features 

 
 

Disk Image File 

What is a disk image file? 
A disk image is a file whose content is an exact raw copy of a drive. For example, in the 
figure below, the file “dump_0_2015231.dsk” is the disk image of drive Q, a 1 GB thumb 
drive. 

 

 
Figure 7.1: “dump_0_2015231.dsk” is the disk image file of drive Q. 
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Figure 7.2: Properties of drive Q. 

Creating a disk image file 
You can use File Scavenger® create a disk image file of a drive in working order. For 
partially faulty drives with bad media spots, our Disk Recoup™ can be much more 
effective.  
 
Drives not detected by the computer BIOS must first be physically repaired. 
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To create a disk image file with File Scavenger®, select the subject drive in the Look In 
box: 

 

 
Figure 7.3: Select the subject disk. 

 
 
 

Click File, Disk Image, Create.  
 

 
Figure 7.4: Commands to create a disk image. 

 



 

User Guide - 39

After reading the warning, click “I have read …” and specify a destination folder. Choose 
Binary format and click Create. 

 

 
 

Figure 7.5: Create a disk image. 
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The program will display a progress dialog as follows: 

 

 
 

Figure 7.6: Progress of disk image creation. 

Benefits of a disk image file 
A disk image file can be useful in the following cases: 
• It can be used in place of the actual disk, which can be put away for safe-keeping. 
• When using File Scavenger® on a partially faulty drive, the program may not be able 

to complete the scan due to hardware errors. However, you can use a utility such as 
our Disk Recoup™ to create a disk image file and scan it in place of the drive to 
avoid interruption. 
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Using a disk image file in File Scavenger 
Click File, Disk Image, Load. Browse to and select a disk image file. 

 

 
 

Figure 7.7: Commands to load a disk image for use by File Scavenger®. 
 

 

 
 

Figure 7.8: Select the disk image file for loading. 
 



  

 
User Guide - 42 

From then on the file will appear in the Look In selection list like an ordinary drive. 
 

 
 

Figure 7.9: Select a disk image file for searching. 
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Saving and Restoring a File Scavenger® Session 

What is a session file? 
Your recovery effort may have to be suspended for many reasons, for example, leaving 
the office at the end of a work day. With this feature, you can save the current session. 
You can reload it at a later time and continue the session where it was stopped. 
 
A session file can be a great time saver when a drive has been scanned using the Long 
Search, which may take a few hours.  

Saving a File Scavenger® session 
Click File, Session, Save. Select a folder and filename to save the session file in. This 
folder must not be on the subject drive. Depending on the number of files found, a 
session file can be a few kilobytes to tens of megabytes or even larger. 
 
You can optionally save the list of found files in a .csv file that can be manipulated in 
Excel. 
 

 
 

Figure 7.10: Commands to save a session. 
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Figure 7.11: Save a session. 

Loading a File Scavenger® session file 
To resume the session, start File Scavenger® and click File, Session, Load. Select and 
load the saved session file. 

 

 
 

Figure 7.12: Commands to load a session. 
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Partial Search 
This command limits the number of files to search for when there is insufficient computer 
memory (RAM) to search for all files at once. Do not use this command unless you observe 
obvious symptoms of memory shortage such as explicit error messages. 
 
Memory usage status can be monitored in the Windows Task Manager. Each group of 5,000 
files requires about 1 MB of memory. For example, if you expect 2,000,000 files to be found, 
the computer should have about 400 MB of memory in addition to the base amount that 
Windows® itself requires.  
 
When memory is lacking, the computer may enter a “thrashing” state. Performance can 
become severely degraded, causing unusually long search times. In the most severe cases, 
File Scavenger® may even abort with “Out of memory” errors. In the example just 
mentioned, if your computer has only 256 MB of RAM, you should limit the search to 
1,000,000 files at a time. That means searching the disk twice as follows: 

• Search for 1,000,000 files. Recover those files. 
• Search for the remaining files after skipping the first 1,000,000 files. Then recover 

them. 
 
The end results should be identical to searching for all files at once with sufficient memory. 

Handling Bad Media Spots 
When encountering bad media spots on a disk, File Scavenger® may hang. In that case, the 
program usually displays the location of the bad spots. 

 

 
 

Figure 7.13: Error messages regarding bad media spots. 
 

File Scavenger® usually displays the errors a few times and moves on. Occasionally, 
however, it may hang. In that case, the program (or even Windows® in some cases) must be 
restarted. 
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Excluding bad sectors from the search 
To avoid the bad sectors, click Options, Search, Sector Exclusion. Specify the range of 
sectors to be excluded and add them to the exclusion list. 

 

 
 

Figure 7.14: Commands to exclude bad sectors. 
 

 

 
 

Figure 7.15: Choose ranges of sectors to exclude. 
 

Note that the error messages display the range in which the bad sectors are located. But 
the error messages do not tell you the exact position of the bad sectors. By excluding an 
entire range, you may exclude some good sectors as well. 

Saving the list of bad sector numbers 
You can conveniently save the list of bad sectors in the Sector Exclusion dialog so that 
they do not need to be typed in again if File Scavenger® is restarted. To do that, save the 
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File Scavenger® session to a file and reload it later. The excluded sectors will be 
restored. See Saving And Restoring a Session earlier in this chapter. 

Using our Disk Recoup™ 
This powerful utility can extract data from a partially faulty disk to a disk image file. (See 
“Disk Image File” earlier in this chapter.) Note the following: 

1. The amount of data extracted may not be 100% but is almost always better than 
scanning the disk directly using File Scavenger®. 

2. If a disk is completely faulty and is not recognized by the BIOS or displayed in 
Windows Disk Manager, then this utility will not work. The disk needs physical 
repair. 

Volume Affiliation 
In almost all cases, you do not need to use this option. File Scavenger® usually can determine 
with certainty which volume a file belongs to. This option is necessary only for volumes or 
partitions that been severely corrupted after being resized, relocated, deleted, etc. 
 
To avoid repetition, the term “volume” is used in place of “partition or volume”. Technically, 
a drive letter (such as drive C) is called a partition on a basic disk or a volume on a dynamic 
disk. 

Files and their volume affiliation 
The Volume column displays what File Scavenger® determines as the volume to which a 
file belongs to. The corresponding drive letter is displayed if it is available. If a volume is 
defunct or has no drive letter, File Scavenger® will assign to the volume a sequential 
volume number, which is the order the volume is detected by File Scavenger®. This 
number has no other meaning. 
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Figure 7.16: Many volumes are found during a search. 
 

A file must be affiliated with the correct volume to be recovered successfully. As 
mentioned above, File Scavenger® should perform this association for you in all but the 
most severe cases of disk corruption. 
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Unknown Volume 
Sometimes File Scavenger® cannot determine unambiguously which volume a file 
belongs to, such as when overlapping defunct volumes are detected. In some other cases, 
a file may not belong to any detected volume, such as when the volume the file belonged 
to has been overwritten completely and could not be detected. In both cases, the file is 
displayed under Unknown Volume, and the Volume column is left blank. 

 
 

 
 

Figure 7.17: Files with ambiguous or no volume affiliation. 
 

When you recover files with ambiguous volume affiliation, multiple copies are recovered 
with the (1), (2), etc. suffixes after the filename. Only the copy from the correct volume 
will be usable, provided that the data has not been overwritten. 
 
When you recover files that have been determined as not belonging to any detected 
volume, you will receive the error “File does not belong to any volume.” If you know 
which volume they belong to, click Options, Recovery, Volume Affiliation and select 
(clicking on the second radio button) or specify (by clicking on the third radio button) the 
volume. 
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Figure 7.18: Commands to choose volume affiliation. 
 
 

 
 

Figure 7.19: Volume affiliation dialog. 
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Overwrite Mode 
 

 
 

Figure 7.20: Overwriting files in an anticipated destination folder. 
 
During recovery File Scavenger® reconstructs original files in memory and copies them to 
the destination folder. The filename may already exist in the destination folder for many 
reasons such as the following: 

• A file with an identical name and folder path was recovered earlier. 
• The destination folder is not empty, and a file with an identical name already exists. 

(You should always use an empty folder as the destination folder.) 
 
This option tells File Scavenger® how to handle such conflicts.  

Use the more recent file 
By default, File Scavenger® will keep the more recent file, that is: 

• If the file to be recovered has a later date, it will replace the existing file. 
• If the file to be recovered is older, it will be skipped. 
• If the file to be recovered has the exact same date and time, it will be copied to 

the folder with a unique number suffix appended to the filename. 
 
This mode is chosen as the default because the most recent version is usually what you 
need. 

Generate a new unique filename 
With this option, the recovered filename will be appended with a unique number suffix if 
the original filename already exists. This choice guarantees all files will be recovered at 
the expense of having to sift through all the files. 
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Overwrite 
 
Always overwrite any existing filename in the destination folder. This choice is of limited 
use because it may produce unpredictable results. When recovering two or more files of 
the same filename and folder path, only the last recovered file is kept. Being last is a 
function of the position of the files in the File Scavenger® display, which can be 
arranged in many ways, such as by date, size, volume, etc. 

Skip 
 
Never overwrite an existing file. Similar to Overwrite, this option is of limited use 
because only the first file is recovered.  
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Chapter 8: 
Features 

 
 

Media Formats 

• Almost all online storage media such as hard drives, removable drives, memory sticks, 
floppy disks, CDs, DVDs, etc. 

• Both basic and dynamic disks. 
• Broken RAID 0 or RAID 5. 
• Broken RAID 6 with our fee-based RAID recovery service. (See “Chapter 20: RAID 

Recovery Services.”) 
• Broken spanned volume sets.  
• Disk image files 
• Disks with some bad media spots. 
• FAT/FAT and NTFS partitions including compressed NTFS partitions. 

Causes of Data Loss 

• Drive reformatting or deletion. 
• Drive corruption. 
• Badly damaged partitions. 
• Deletion of pictures from digital camera storage media. 
• Deletion of files from a network shared folder. (File Scavenger® must be run on the 

computer where the share is located.)  
• Deletion of files in a command window. 
• Deletion of files from Windows Explorer, including the Recycle Bin.  
• Broken RAIDs. 

Types of Files 
 
File Scavenger®: 

• Can recover all file types even though large and fragmented files such as databases 
and email folders are less likely to be recovered. 

• Is especially effective in recovering digital images in JPEG, TIFF and BMP format.  
• Can detect certain file types based on their data patterns, thus allowing recovery even 

when the file system structure is totally lost.  

What Are Recovered? 
• The original filename and folder path. 
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• Alternate data streams and sparse files.  
• The original Create and Modified file dates and times.  
• Unicode filenames. 

Availability 
 

• Windows® 7, Vista, XP, 2008, 2003, 2000, and NT. 
• English, Dutch, French, German, Italian, Japanese, and Swedish. 

Ease of Use 
 
File Scavenger® can: 

• Search for file patterns or file types.  
• Recover multiple files in one click.  
• Sort files by date, size, name, type, path, etc.  
• Save a search session to a file for reloading later so that a drive need not be scanned 

again.  

Performance 

• Scans very large volumes (hundreds of gigabytes) holding up to several million files or more 
on a computer with sufficient RAM.  

• Has been optimized for fast searching and efficient usage of computer resources. 
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Chapter 9: 
Dialogs 

 
 

About File Scavenger® 
 
Help → About File Scavenger® 

 

 
 

Figure 9.1: About File Scavenger®. 
 

This dialog displays the copyright statements and the current software version and revision 
numbers. It also shows the modified date of the executable file. 

 
Show License Agreement: Display the End-User Licensing Agreement. 

Creating a Disk Image File 
 
File → Disk Image → Create 

 
See “Disk Image File” in Chapter 7 for information about the use of disk image files. 
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Figure 9.2: Creating a disk image file. 
 

I have read the WARNING above: Check this box to acknowledge you have read the 
warning about not creating a disk image file on the drive holding the lost data. 
 
Source drive: The drive from which the disk image file is being created. 
 
Destination Folder: The folder in which the disk image file is being created. The folder must 
be located on a drive with as much free space as displayed in the Disk space required field. 
For best performance, use a newly-formatted internal drive. 
 
Binary: Creates a disk image file in binary format to be used by programs such as File 
Scavenger®. 
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Text: Creates a disk image file readable by humans but not usable by programs. This option 
allows our technical support staff to dump a small range of sectors for viewing.  
 

First sector: The first sector from which data is to be copied. 
 

Last sector: The last sector to copy. 
 

Disk space required: The minimum amount of free disk space required on the destination 
drive for this action.  

Creating a Disk Image 
 

This dialog displays the disk image creating progress. The fields are self-explanatory. 
 

 
 

Figure 9.3: Disk image creation progress. 

Determining the Boot Sector 
 

This dialog lets you override the location of the boot sector as determined by File 
Scavenger®. You should usually accept the displayed value by clicking OK. 

 

 
 



  

 
User Guide - 58 

Figure 9.4: Determining the boot sector. 

End-user Licensing Agreement 
Help → About File Scavenger® → Show License Agreement 

 
This dialog displays the end-user licensing agreement. 

 

Error Messages  
 

 
 

Figure 9.5: Error messages are displayed in a separate window. 
 

Maximum number of error messages: The most number of lines that will be written to this 
window. A larger value will require more computer memory (RAM).  

 
Apply: Applies the new maximum. 
 
When maximum error count is reached, overwrite old messages: 

Check this box to cause the error message display to wraparound when the limit is 
reached. Clear this box to stop displaying new error messages when the limit is reached. 

 
Save: Saves the displayed error messages to a file. Do not save them to the drive holding the 
lost data. 
 
Close: Closes this dialog. 
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Find 
 
Edit → Find 

 

 
 

Figure 9.6: Finding a filename in the list of files. 
 

This dialog lets you search for a string in the file display dialog. 
 

Find what: What string to look for, such as a filename, date or file type, etc. 
 

Match whole word only: Only looks for whole-word matches. For example, if you are 
searching for “port”, “import” will not match. 

 
Match case: Considers casing. For example, “Port” will not match “port.” 
 
Direction: Searches up or down. 
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Launching Internet Browser  
Help → Licenses → Launch Internet Explorer 

 

 
 

Figure 9.7: Launching the Internet browser to purchase a license. 
 

A browser such as Internet Explorer may write new data to the system drive (usually drive C) 
or the drive containing the browser cache (also usually drive C). If you are recovering from 
the system drive or one containing the browser cache, using the Internet browser will reduce 
your chances of a successful recovery. See “Step 1: Protect the Subject Drive” in Chapter 3. 

 
I have read the warning above: To enable the Launch Internet browser button, check this 
box to acknowledge you have read the warning.  
 
Launch Internet browser: Launches the Internet browser to connect to our web site to 
purchase a license. 
 
Cancel: Cancels the request and returns to the Licenses dialog. 

Licenses 
Help → Licenses 

 
See “Purchasing a License” in Chapter 6. 
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Main Dialog 
 
 
 

 
 

Figure 9.8: The main dialog window. 
 
 
The main dialog consists of five areas: 
 

• Menu bar. 
• Toolbar. 
• Command section. 
• File display area. 
• Status bar. 

Menu ToolbarSearch section Recover section 

File display area Status bar 
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Menu bar 
See “Chapter 10: Menus.” 

Toolbar  
The toolbar offers buttons to: 

• Display advanced RAID and spanned volume recovery. 
• Display properties of the selected file. 
• Display files in folder or list view. 
• Display licensing information. 
• Display online Help information. 

Command section  
In “Step 1: Search” the following are displayed: 
 
Search for: Specifies what files are being searched for. Click on the drop-down list to 
select one or more types of files. You should leave the default value “*” to search for all 
files. 

 

 
 

Figure 9.9: Search specification. 
 

Instead of selecting the checkboxes, you can also type in a filename to search for, 
optionally with the pattern-matching character ‘’*’’. For example: 

 

 
Figure 9.10: Search specification. 

 
Search for the filename “myfile.txt”. 

 

 
Figure 9.11: Search specification. 

 
Search for text files (*.txt) such as “myfile.txt”, “doc1.txt”, etc. 

 

 
Figure 9.12: Search specification. 

 
Search for text files beginning with an ‘‘a’‘, such as ‘‘abc.txt’‘, ‘‘afile.txt’‘, etc. 
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Figure 9.13: Search specification. 
 

Search for text, Word (*.doc) and Excel (*.xls) files. 
 

Look In: Selects a volume or disk to perform the search on. 
 

 
 

Figure 9.14: Select a volume or disk number to search. 
 

Choose Refresh to update the list of volumes and disks, for example, after a removable 
drive is added or removed. 
 
Mapped network drives are not displayed as available choices. To recover data from a 
mapped network drive, you must run File Scavenger® on the computer where the drive 
physically resides. 
 
If a drive is corrupted or its integrity otherwise compromised, you may get better results 
by searching the disk number that holds the drive letter. For example, if drive D on Disk 
0 is corrupted, search Disk 0. 

 
Quick or Long Search: See “Quick versus Long Search” in Chapter 6. 
 
Search: Start searching. 
 
In “Step 2: Recover,” the following are displayed: 
 
Destination Folder: Folder to copy recovered data to. You can type in a folder path or 
use the Browse button to select a folder. This folder should not be on the subject drive. 
See “Destination Folder” in Chapter 6 for details. 
 
Use Folder Names: Restore the original folder names. For example, in the scenario 
below: 
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Figure 9.15: Restore folder name. 
 

If this option is checked, the path of the recovered file will be:  
 
D:\Recover\Images\Install\inst2.bmp 
 
If it is not checked, the file will be recovered without its original folder path: 
 
D:\Recover\inst2.bmp 
 
Recover: Starts recovering. 
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File display area 
 

 
 

Figure 9.16: Files in List View. 
 

Files are displayed in either List View or Tree View. In List View, files can be sorted by 
Filename, Type, Folder, Volume, Status, Size or Modified Date. 
 
Volume: The volume this file is determined to belong to.  
 
Status: After searching, the status can be Good or Poor, indicating whether the 
corresponding file is more or less likely to be recovered successfully. If the status cannot 
be determined, it will be left blank. A blank status does not mean the file is unrecoverable 
or unlikely to be recovered.  
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After recovery, the status can change to the following: 
 
• Recovered: The file was recovered. However, there is no guarantee the contents of 

the recovered file are still intact. You need to open the file to validate it. 
• Failed: The file was not recovered because of an error displayed in a separate error 

window. 
• Skipped: The file was skipped based on the selected Overwrite Mode. An empty 

file is also skipped if the filename already exists. 
 
Size: The size of the file. The exact number of bytes is displayed inside the parentheses. 
 
Modified Date: The date and time stamp of the last change made to the file. The Created 
Date is not displayed but will be restored when the file is recovered. 

Status bar 
The status bar displays program status in four areas: 

• Program message area. 
• Number of files found during the search. 
• Number and size of files selected for recovery. 
• Number of recovered and failed files 

 

 
 
 
 
 

Figure 9.17: Status bar. 
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Opening Online Help 
Help → Help Topics 

 

 
 

Figure 9.18: Opening online Help. 
 

The online Help writes a few new files to the system drive (usually drive C) each time it is 
used. If you are recovering from the system drive, using online Help will slightly reduce your 
chances of a successful recovery.  

 
Do not display this message again: Suppresses further warnings. 
 
Open Help: Opens online Help. 
 
Cancel: Cancels the request and returns to the Licenses dialog. 

Overwrite Mode  
Options → Recovery → Overwrite mode 
 
See “Overwrite Mode” in Chapter 7. 
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Partial Search 
Options → Search → Partial Search 
 
This dialog lets you search for a limited number of files when the computer lacks sufficient 
memory to search for all files. 
 
Please see “Partial Search” in Chapter 7 for more information. 
 

 
 

Figure 9.19: Partial search. 
 

Search for up to … files: Number of files to search for and display  
 
After skipping the first … files: Number of files to skip first. 
 
Reset: Resets the values above to the default values of searching for all files and skipping 
none. 
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Preview 
File → Preview 
 
This dialog is similar to “Properties of a File” below with the addition of a preview picture on 
the left. The command Preview is only displayed in the File menu when you select a picture 
file in the file display area. 
 

 
 

Figure 9.20: Preview of a picture file. 
 

If the picture is corrupt or otherwise cannot be displayed, an error will be displayed. 
 

 
 

Figure 9.21: A corrupt picture file. 
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Properties of a File 
File → Properties 

 
Highlight a file in the file display area and click File, Properties. 

 

 
 

Figure 9.22: Properties of “00010004.wid”. 
 

Filename: The filename 
 
Folder: The parent folder. 
 
Modified Date: The date and time of the last change made to the file. 
 
Size: The file size. The number in parentheses is the exact size in bytes. 
 
MFT Record Number: The internal file record number of the file for tracing and debugging 

purposes. 
 
MFT Entry Sector Number: The location on disk of the file record. 
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Properties of a Volume 
File → Properties. 

 
In Tree View highlight a volume in the file display area and click File, Properties. 

 

 
 

Figure 9.23: Properties of volume C. 
 

Label: The label of the volume. 
 
Volume: For an active volume, this is the drive letter assigned by Windows® to the volume. 

For a defunct or otherwise inactive volume, this is a number indicating the order in 
which the volume was detected by File Scavenger®. 

 
Starting sector: The disk position where the volume was found. 
 
Size: The total size of the volume including unused space. 
 
File system: The type of file system on the volume. File Scavenger® supports NTFS and 

FAT/FAT32. Recovery from FAT/FAT32 volumes usually provides mixed 
results. See “Chapter 11: FAT and FAT32 Partitions.” 
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Recovering Data to the Same Drive  
 

 
 

Figure 9.24: Recovering files to the same drive. 
 

This dialog warns the user about the consequences of recovering data to the same drive. In the 
figure above, the user is attempting to recover a file found on drive C to a destination folder 
also on drive C. 
 

See “Destination Folder” in Chapter 6 for more details. 
 

If you have no other drives and are willing to risk overwriting lost data permanently (with no 
chance of recovery), click the checkbox and type Yes to override this warning. 

Saving the Current Session  
File → Session → Save 
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See “Saving and Restoring a File Scavenger® Session” in Chapter 7. 

Sectors Exclusion 
Options → Search → Sector Exclusion 
 
See “Handling Bad Media Spots” in Chapter 7 for information about when this dialog is 
helpful. 

 

 
 

Figure 9.25: Sector exclusion. 
 

Drive: The drive or volume being scanned. 
 
Sector Range: The valid range of sector numbers on this drive. 
 
From: The first sector of a new range to be excluded. 
 
To: The last sector of a new range to be excluded. 
 
Add: Adds this range to the list. 
 
Remove: Removes the highlighted range from the list. 
 
Excluded Sectors: Ranges of sectors to be excluded from the next search. 
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Trace 
 

Use this only when requested by our Technical Support team. 
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Volume or Partition Affiliation 
Options → Recover → Volume or Partition Affiliation 

 
See also “Volume Affiliation” in Chapter 7. 
 
It seldom happens, but if File Scavenger® cannot determine (or incorrectly determines) the 
volume a file belongs to, you will receive an error such as “The file above does not belong to 
any known volume.” You may need to click the middle radio button and select what you 
think is the correct volume. If the volume size has changed, also check the option Overriding 
volume size. Use the default Overriding size if you do not know what it was. 
 
The procedure above will work in the following scenario. Drive C was 100 GB. A file was 
stored near the end of the drive. Drive C was reformatted and reduced to 50 GB. A Long 
Search on drive C may find the file because the file index entry may lie within the new 
boundary of drive C and still be intact. However, the data lies beyond the end of the new 
drive C and will not be recovered. You must choose to affiliate the file with volume C and 
override the volume size with the default maximum value. 

 
 

 
 

Figure 9.26: Override the volume size. 
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Chapter 10: 
Menus 

 
 

File 

Search  
Searches for files based on the search options selected. See “Searching for Files” in 
Chapter 6. 

Recover 
Recovers the files selected from the list in the file display area. See “Recovering Data” in 
Chapter 6. 

Stop 
Aborts the current search or recovery activity.  

Properties or Preview 
See “Preview”, “Properties of a File”  and “Properties of a Volume” in Chapter 9. 

Session 
See “Saving and Restoring a File Scavenger® Session” in Chapter 7. 

 
Save: Saves the current state of File Scavenger® to a disk file.  
 
Load: Restores a previously saved session. 

Disk Image 
See “Disk Image File” in Chapter 7.  

 
Load: Adds a disk image file to the Look In box as an available choice. 

 
Create: Creates a disk image file from the drive being selected in Look In. 

Exit 
Quits File Scavenger. 
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Edit 

Find  
See “Find” in Chapter 9. 

Select All 
Selects all files for recovery. 

Deselect All 
Deselects all files. 

Invert Selection 
Inverts the selection status of files 

Options, Search 

Partial Search 
See “Partial Search” in Chapter 9. 

Sector Exclusion 
See “Handling Bad Media Spots” in Chapter 7. 

Skip Deleted Files and Folders 
This option can be used to skip deleted files to keep the results less cluttered when 
searching for files lost due causes other than accidental deletion (such as volume 
corruption or RAID failure). 

Options, Recovery 

Use Folder Names 
See “Command section” in Chapter 9. 

Volume Affiliation 
See “Volume or Partition Affiliation” in Chapter 9. 

Overwrite Mode 
See “Overwrite Mode” in Chapter 7. 

Options, Trace 
Use this command only if requested by our Technical Support staff. 
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View 

Toolbar 
Shows or hides the toolbar. See “Toolbar” in Chapter 9. 

Status Bar 
Shows or hides the status bar. See “Status bar” in Chapter 9. 

Arranges Files 
Sorts displayed files by a column such as Name, Size, etc. See also “Recovering Data” in 
Chapter 6. 

Tree View or List View 
See “Recovering Data” in Chapter 6. 

Help 

Help Topics 
Offers you an index to topics on which you can get help. 

Licenses 
See “Purchasing a License” in Chapter 6. 

About File Scavenger 
See “About File Scavenger®” in Chapter 9. 
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Chapter 11: 
FAT and FAT32 Partitions 

 
 

Due to the inherent structure of the FAT and FAT32 file systems, recovery is limited under 
many conditions. To the best of our knowledge, all data recovery tools face this issue. Please 
consult the table below before making a purchase. 
 

  Contiguous files  Fragmented files 
 Deleted or corrupted partition   Usually recoverable   Usually recoverable  
 Accidentally deleted files   Usually recoverable   Not recoverable  
 Reformatted partition   Usually recoverable   Not recoverable  

 
A contiguous file is stored on disk as a series of contiguous physical sectors. A fragmented 
file, conversely, is stored in two or more disjoint disk segments. 
 
A file is usually contiguous when first copied to a partition. Subsequent changes to the file 
that increase its size will require Windows® to allocate additional disk sectors, causing the 
file to become fragmented. 
 
Certain types of files such as pictures and music files are almost never changed and, 
therefore, are usually contiguous and recoverable in all cases. On the other hand, Microsoft 
Office® documents and email storage files (for example, Microsoft Outlook® folders) can be 
routinely edited and quickly become fragmented. 
 
When a fragmented file is copied to another folder, the new copy is usually contiguous. When 
a fragmented file is moved to another folder, the file stays fragmented if the new folder is on 
the same partition. If the new folder is on another partition (such as when moving a file from 
drive C to drive D), the file usually becomes contiguous.  
 
If a partition is defragmented using Windows® system tools, fragmented files with sizes up to 
a few tens of megabytes usually become contiguous again. Note that if files are already lost, 
defragmenting a partition will only worsen the situation.  
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Chapter 12: 
Troubleshooting Guide 

 
 

Common Scenarios Requiring File Scavenger® 

A drive becomes corrupt and inaccessible 
A drive can become corrupt because of hardware faults, power interruption, improper 
disconnection from a computer, etc. The following are common: 

• Windows Explorer asks you to reformat it. 
• Disk Manager shows “Unallocated” status. 
• Windows® asks for your permission to repair the drive when the computer is 

booted up. (If you choose to proceed, it will run the ScanDisk utility, which may 
recover many lost files, but also make irreversible change to the drive, further 
worsening the situation. You must avoid using this utility. File Scavenger®, in 
contrast, only scans the drive and makes no changes to it.) 

 

 
Figure 12.1: A corrupt drive is not accessible via Windows®. 
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Figure 12.2: A partition was deleted and the space is now marked as Unallocated. 

 
In many cases, you will get the best results by using the Quick Search and selecting the 
disk number (such as Disk 0) in the Look In box. This search, if successful, will recover 
only the required files. If necessary use the Long Search, which may also recover 
defunct files of no interest to you. (See “Quick versus Long Search” in Chapter 6.) 

Windows® was reinstalled (possibly from a Recovery CD) 
Windows® may have been reinstalled accidentally or intentionally.  Files in such folders 
as My Documents and Desktop are lost after the reinstallation.  
 
Many computers come with a Recovery CD from which you can boot to restore the 
computer to the original state. If this procedure is performed, all data files on drive C will 
be lost. 
 
Follow the procedures described in “Chapter 4: Recovering Files from a System Drive.” 
The Long Search must be used because the original file system structure has been 
overwritten. 

Files and folders were accidentally deleted 
Depending whether the subject drive is a system or data drive, you should follow the 
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appropriate procedure to write-protect it. See “Chapter 2: Data or System Drive?” Since 
the file system structure is intact, use the Quick Search first and the Long Search only if 
necessary. 

 
In Windows® XP, 2003, 2000 and NT, files removed from the Recycle Bin may be 
renamed to the following internal format: 

 
D + drive letter + random number + original file extension. 

 
For example, “myfile.doc” on drive E may be renamed to “DE34.doc”. In most cases, 
File Scavenger® can restore and display the original names. In some cases, however, this 
is not possible, and the internal Recycle Bin names are displayed. 

 
In Windows® 7 and Vista the internal Recycle Bin filenames are: 
 

$R + 6 random letters or numbers + original file extension 
 
For example, “myfile.doc” may be renamed to “$RKEF1E2.doc”. 

Files mysteriously disappeared 
This is similar to “Accidental deletion” discussed earlier in this chapter. 

The computer cannot boot 
You can follow the “Safe Procedures” in Chapter 4.  

Failed RAIDs 
See “Chapter 13: Overview of RAID Reconstruction.” 

Failed spanned volumes 
See “Chapter 21: Overview of Spanned Volume Reconstruction.” 

Common Problems When Using File Scavenger® 

The license key is not accepted 
You can follow the trouble-shooting procedure below: 

1. Have you bought a license? If not, see “Purchasing a License” in Chapter 6. 
2. Is the license for the correct software version? If not, see “Purchasing a License” 

in Chapter 6. 
3. Is it a Personal-Use or Professional-Use license? If it is a Professional-Use 

license, contact Technical Support by sending an email to help@quetek.com or 
calling 866-722-0584. 

4. Is the program being used on the original computer for which it was bought? If 
no, see (6). If yes, see (5). 

5. Visit http://www.quetek.com/cgi-bin/xferlicn to get a new license key. 
6. Is this computer a replacement for the original computer? If no, see (7). If yes, 

see (5). 

mailto:help@quetek.com�
http://www.quetek.com/cgi-bin/xferlicn�
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7. You must purchase an additional Personal-Use license or upgrade to the 
Professional-Use license. 

The desired files are not found 
The files may have been found but are hidden in the file display area. Click on the toolbar 
button List View if necessary to switch to this view for ease of searching. Files are not 
always displayed in the correct folder and following the folder structure to look for a 
particular file is not always successful. After switching to List View, search for the files 
by one of the following methods: 

• Click Edit, Find and search for the filename. 
• Click on the heading Filename or Type to sort and look for the files. 

 
You can also narrow the Search for criteria. For example, you can use “*.doc” (without 
the quotation marks) to search for Microsoft Word documents. 
 
If the files are still not found: 

• Use Long Search to search the corresponding disk number (such as Disk 1). 
• Windows® may have renamed the files. See “Files and folders were accidentally 

deleted” in this chapter. 
• The original filenames may have been lost and the files are displayed as 

“Unknown…” (for example, “Unknown000002.doc”). See “Files without the 
original filename” in Chapter 6. 

The displayed files cannot be recovered 
If the error is related to the destination folder, check for sufficient free space and folder 
permissions. 

 
If the error occurs while a file is being recovered, try the combination of the Long 
Search and selecting a disk number (such as Disk 1). This may work when other options 
fail. 

 
The data may also be corrupt beyond recovery. 

The recovered files are corrupt 
Either the data is actually corrupt or the recovery has been performed incorrectly. 
 
In a simple scenario such as accidental file deletion, the files may have been partially 
overwritten. They may be displayed with the correct name, dates and folder, but their 
contents are at least partially overwritten. Overwritten data cannot be recovered. 
 
If a drive is corrupted or its integrity otherwise compromised, you may get better results 
by searching the disk number that holds the drive letter. For example, if drive D on Disk 
0 is corrupted, search Disk 0. 
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Error Messages 
Access is denied. 

A drive cannot be accessed for searching. The most likely cause is you are not logged on 
as an Administrator. 

 
Block size must be a power of 2 

This error may occur in the Striping Block Size dialog (see “Stripe (Block) Size” in 
Chapter 19). A RAID block size must be a power of 2, such as 1, 2, 4, 8, 16, 32, 64, 128, 
256, etc. 

 
Boot sector not found. Please use the Long Search. 

The file system structure on the drive is corrupt. You must use the Long Search.  
 
Cannot recover a system file. 

Files starting with a “$” such as “$MFT”, “$MFTMirr”, “$Volume”, and “$Bitmap”, are 
not user data files. They are used internally by Windows® and cannot be recovered. 

 
CD-RW/DVD drives typically cannot be used for saving recovered files because they 
require a staging folder on drive C. 

See “Destination Folder” in Chapter 6. 
 
Data cannot be saved to the Windows system folder. 

You are performing an operation in this program that would write new files to the 
Windows® system folder, potentially causing system problems. For example, you may 
have specified the Windows® folder or one of its subfolders as the Destination Folder. 
To avoid this error, choose a non-system folder. 

 
Disk <disk> not found. 

A device (such as “Disk 1”) is no longer available. It may have gone offline. Use the 
Windows Disk Manager utility to check the status of the device. 

 
<Drive> does not exist on this computer. 

This error appears when you load a session file that references a non-existent drive or 
disk image file. The most likely cause is a configuration change causing the drive to be 
assigned a different drive letter or disk number. 

 
Error <code>  accessing <drive>: <additional message>. 

When you start File Scavenger® you may see the following message: 
 

 
 

Figure 12.3: Disk access error. 
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This error message means File Scavenger® cannot access the disk device because of the 
reason explained in the text after the colon. The string “\\.\PhysicalDrive1” is the internal 
name for “Disk 1”. In this example, Disk 1 is being used by another program. 

 
If the disk is irrelevant in your recovery effort, you can simply ignore the error.  

 
Error accessing the destination folder. 

Data cannot be written to the destination folder. Check for folder permissions and free 
space availability on the destination drive. Note that data usually cannot be recovered to a 
CD or DVD drive. See “Destination Folder” in Chapter 6. 

 
Error parsing MFT extended entry inode # <n>: <error text>. Please choose the Long 
Search. 

The file system structure on the drive is corrupt. You must use the Long Search. 
 
Incomplete write. The drive may be full. 

The drive letter containing the destination folder may be full. Use Windows Explorer to 
check the amount of free space on the drive. This error also occurs if you recover a file 
larger than 4 GB to a FAT32 destination drive. By design, a FAT32 partition cannot hold 
a file larger than 4 GB. 

 
Invalid First or Last Sector 

This error can occur when you create a disk image file (see “Disk Image File” in Chapter 
7) or exclude bad sectors from a search (see “Handling Bad Media Spots” in Chapter 7. 
The sector number must be within the valid range from 0 to the last sector number of the 
source drive. 

 
Invalid license key. 

You typed in an incorrect Personal-Use License Key in the Licenses dialog. Please check 
the license key and try again. If you need to purchase a license, see “Purchasing a 
License” in Chapter 6. 

 
The Personal-Use license key is valid on one specific computer. Trying to use it on 
another computer will result in this error. If you replace an old computer with a new one, 
please visit 
 
http://www.quetek.cm/cgi-bin/xferlicn 
 
The Professional-Use license is a roaming license and can be used on any computer by a 
specific licensee. 

 
Invalid trace filename. 

Tracing can only be turned on if requested by our Technical Support team. 
 
Invalid or expired license file. 

The Professional-Use license file is either expired or for an older version of this program. 
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Invalid size. 
This error can occur in the Volume or Partition Affiliation dialog (see “Volume or 
Partition Affiliation” in Chapter 9). The volume size you specified exceeds the physical 
size of the disk. Specify a size smaller than the physical size to avoid this error. 

 
Maximum errors exceeded. Program continues without displaying errors. 

See “Error Messages” in Chapter 9. 
 
Media errors reading sectors <#> to <#> on <drive>. Use Options, Search, Sector 
Exclusion to skip bad sectors. 

The program has encountered a bad media spot on disk. If the program hangs, restart it 
and use the suggested command to exclude the offending sectors from the next search. 

 
To avoid having to retype the excluded sectors every time the program is started, see 
“Saving the list of bad sector numbers” in Chapter 7. 

 
When encountering many bad sectors, you can try our Disk Recoup™ which specifically 
addresses this problem. Please visit our web site http://www.quetek.com/diskrecoup for 
more information. 

 
No preview is available. The file may be corrupt. 

The picture you are trying to preview is corrupt and cannot be displayed. See “Recovered 
files are corrupt” in this chapter. 

 
No files found. You may want to try the Long Search. 

A corrupt drive has lost critical information. The Quick Search relies on such 
information and, therefore, cannot be used. 

 
Out of memory. 

The computer is using up all available memory (RAM) because too many files have been 
found. On a computer with more than 2 GB of RAM, the limit in Version 3.2 is a few 
million files. The actual number depends on the folder structure and filename lengths. 
 
To avoid this error, use the “Partial Search” described in Chapter 7. 
 

Reading sectors <#> to <#> on <drive> ... 
The program is encountering a problem reading data from the sectors mentioned in the 
message. If this message appears only once, the program has moved on, and you need not 
take any action. If it is repeatedly displayed many times for the same sectors, the program 
is hung on the bad spot and has to be restarted. 
 
To avoid this error, you can exclude the bad sectors and search the drive again. See 
“Handling Bad Media Spots” in Chapter 7. You can also use our Disk Recoup™ to create 
a disk image from the drive. Visit our web site at http://www.quetek.com/diskrecoup for 
more information. 

 
Searching Disk %d in the Long Search mode may produce better results for this file. 

http://www.quetek.com/diskrecoup�
http://www.quetek.com/diskrecoup�
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If a drive is corrupted or its integrity otherwise compromised, you may get better results 
by searching the disk number that holds the drive letter. For example, if drive D on Disk 
0 is corrupted, search Disk 0. 

Skipping zero-size file. 
The file was skipped because it is empty and another file with the same name already 
exists in the destination folder.  

 
Software version and session file are incompatible. 

You cannot load a session file created by an obsolete version of File Scavenger®. 
Contact Technical Support to download and install the older version if it is still available. 
See “Appendix A: Contact & Technical Support.” 

 
The destination folder cannot reside on the source drive. 

When creating a disk image file, you must choose a destination folder that is not on the 
source drive being imaged. 

  
The device <drive> may be offline. Click “File”, “Session” and “Save” to save the current 
session. Bring the device online (a reboot may be required). Rerun File Scavenger® and 
reload the session. 

This message suggests a procedure to deal with the following scenario. After you search 
a drive, it goes offline due to the activity generated by the search. You cannot recover 
data because the drive is no longer accessible. If you reboot the computer to bring the 
drive online, you have to start over and the problem is repeated. 

 
Using this procedure, you save the search results to a session file. Then reboot the 
computer to bring the drive back online. Reload the session and recover data. The drive is 
not searched again and will be online for recovery. 

 
The file above does not belong to any known volume. 

A file has been found but cannot be affiliated with any volume. The volume containing 
the file may have been completely overwritten and cannot be detected during the search. 
See “Volume Affiliation” in Chapter 7. 

 
The file above does not belong to the selected volume. Click “Options”, “Recovery” and 
“Volume Affiliation” to select another volume 

You have affiliated the file being recovered with a specific volume. However, the file 
does not belong to the volume. You must try a different volume. See “Volume 
Affiliation” in Chapter 7. 

 
The file cannot be recovered because the chain of data segments is broken. 

The file is partially corrupt and cannot be recovered. This error usually occurs when 
recovering a very large file that was either highly fragmented or compressed.   

 
The file is corrupt. 

A compressed file cannot be decompressed due to data corruption. See “Recovered files 
are corrupt” in this chapter. 

 
The filename is too long. Please choose a root folder such as D:\ as the destination folder. 
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Windows® imposes a maximum length limit for filenames including the folder path to 
255 characters. When a file is recovered, its recovered name is the original name prefixed 
by the destination folder. For example, when the lost file C:\My Documents\Resume.doc 
is recovered to the destination folder D:\Recovery, the recovered filename will become 
D:\Recovery\My Documents\resume.doc, which is usually longer than the original path. 
If the original path length is near the limit, the new length may exceed it. 

 
To avoid this error, recover the file to a root folder (such as D:\) so that the new path 
name has the same length as the original. 

 
The Quick Search on an active drive always displays deleted files only. The “Skip deleted 
files and folders” option is ignored. 

When you use Quick Search to search an active drive letter (i.e., one that is working 
normally), only deleted files are searched. This is in conflict with the option Skip 
Deleted Files and Folders in the menu Options, Search. To avoid this message, 
uncheck this option. 

 
The trace folder cannot reside on the drive holding the lost data. 

When using the trace facility, you must not use a folder on the drive holding the lost data 
to store trace data. This measure is to prevent the trace data from overwriting the lost data 
being recovered. 

 
There were unreadable sectors. The file was only partially recovered. 

The file has not been recovered completely because some sectors could not be read. The 
recovered file is partially corrupt and may not be usable. See “Recovered files are 
corrupt” in this chapter. 

 
This command is not available in demo mode. 

When using this program in demo mode, you cannot save the session using the 
commands File, Session, and Save. 

 
This command is not applicable to RAID or spanned volumes. Please set this option on the 
component drives. 

You can use the commands Options, Search, and Sector Exclusion to instruct the 
program to skip bad sectors to avoid hanging on them. When reconstructing a RAID or 
spanned volume, you can exclude only bad sectors of component drives, not the RAID or 
spanned volume definition. To do so, select a component drive in the Look In box and 
then click Options, Search and Sector Exclusion. Then you can reselect the RAID 
definition. 

 
If you select a RAID definition in Look In and try to use this command, you will get the 
error above. 

 
This computer does not have that many disks. 

During RAID reconstruction the number of component drives must be less than or equal 
to the actual number of active physical drives on the computer. A RAID 0 can only be 
reconstructed from at least two disks. A RAID 5 requires three disks. If the number of 



 

User Guide - 89

physical drives on the computer is lower than the minimum, File Scavenger will display 
this error. 

 
If a RAID is being reconstructed from disk image files, the files must be loaded (using 
the commands File, Disk Image and Load) prior to reconstruction. A loaded disk image 
file is equivalent to a physical disk. 

 
Unable to access registry key. 

A required Windows® registry key cannot be accessed. This error may indicate a 
potential problem with the Windows® installation. 

 
Unable to access the disk. 

The floppy disk cannot be accessed due to physical media errors. 
 
Unknown error. 

This is a catch-all error when more details are not known. Please report it to our 
Technical Support team. See “Appendix A: Contact & Technical Support.” 

 
Volume is already defined. 

You are defining a RAID or spanned volume for reconstruction. The volume has identical 
settings to another already defined volume. To avoid this error, use the volume that you 
already defined. You can also close and restart this program. 

 
You cannot write data to the drive holding the lost data. 

You are trying to create a trace file or save error messages to the drive containing the lost 
data. This is not allowed to avoid overwriting the lost data. 
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Section IV: RAID and Spanned Volumes 

Chapter 13: 
Overview of RAID Reconstruction 

 
 

Recovering data from a failed RAID can easily turn into a costly ordeal. Please read this 
chapter carefully before proceeding. If you would like to get help from experts, please 
consider using our fee-based RAID recovery services. See “Chapter 20: RAID Recovery 
Services.” 
 
First determine whether the RAID is hardware-based or software-based. The recovery 
procedures are very different. 

RAID 
A RAID is the organization of multiple disks into a larger logical disk for better performance 
and/or availability. There are many levels of RAID; we will discuss levels 0 and 5. 
 
In RAID 0 (or striped volume) data is striped across all disks in a rotating pattern. A RAID 0 
with two 20-GB disks will function as one 40-GB logical disk with no redundancy. If any 
disk fails, data is lost.  
 
In RAID 5 data is also striped across all disks in a rotating pattern but with parity data for 
redundancy. A RAID 5 with three 20-GB disks will function as one 40-GB logical disk. 
Parity information uses up the equivalence of one disk.  
 
A RAID 5 becomes degraded when one disk fails. The RAID, however, still functions 
because the data on the failed disk can be computed using the parity information and data on 
the remaining disks.  

Hardware RAID 
Hardware RAID is implemented in either the motherboard directly or a separate RAID card. 
Windows® detects the RAID as a single disk and cannot access the individual component 
disks which are controlled by the RAID hardware. 
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In the following Windows Disk Manager screen, Disk 2 (drive D) is a hardware RAID 0 
composed of two 18.68-GB disks, displayed as a single 37.35-GB disk. 

 
 

Figure 13.1: A hardware-based RAID. 

Software RAID 
Software RAID is created in Windows Disk Manager. In the screen snapshot below drive D: 
is a software RAID 0 (striped volume) composed of two 18.68-GB disks. 

 

 
 

Figure 13.2: A software-based RAID. 
 

 
 

Figure 13.3: Drive D in Figure 13.2 is shown as a striped volume. 
 

Do It Yourself or Use Our Services 
You can use File Scavenger® to reconstruct a RAID by yourself or use our RAID recovery 
services (see “Chapter 20: RAID Recovery Services.”) If you choose to do it yourself, 
successful recovery depends on your knowledge of the RAID settings and the complexity of 
the RAID configuration. When using our service, successful recovery is almost certain except 
when the component disks are corrupt beyond recovery. 

 
The following tables provide the estimates for your chances of success in a few typical 
scenarios, assuming the component disks are intact. Spanned volumes are not RAID, but the 
analysis and procedures are similar. 
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Level RAID 5 RAID 0 
Number of disks 3 4 2 3 
Doing it yourself  
Success rate 40% 25% 80% 60% 
Cost $185 $185 $89 $89 
Estimated time (days) 1-3 2-4 1 1 
Using our remote 
assistance service 

 

Success rate 95% 95% 95% 95% 
Cost $700 $800 $450 $550 
Estimated time (days) 1 1 1 1 

 
Table 13.1: Predicted recovery outcome for hardware RAID. 

 
Level RAID 5 RAID 0 
Number of disks 3 4 2 3 
Doing it yourself  
Success rate 75% 40% 90% 75% 
Cost $185 $185 $89 $89 
Estimated time (days) 1-3 2-4 1 1 
Using our remote 
assistance service 

 

Success rate 95% 95% 95% 95% 
Cost $700 $800 $450 $550 
Estimated time (days) 1 1 1 1 

 
Table 13.2: Predicted recovery outcome for software RAID. 

 
   
Number of disks 2 3 4 5 
Doing it yourself  
Success rate 60% 50% 40% 30% 
Cost $185 $185 $185 $185 
Estimated time (days) 1 1 1 1 
Using our remote 
assistance service 

 

Success rate 95% 95% 95% 95% 
Cost $700 $800 $900 $1,000 
Estimated time (days) 1 1 1 1 

 
Table 13.3: Predicted recovery outcome for a spanned volume. 

 
Prices are accurate as of September 2010 and are subject to change without notice. Success 
rates and completion times may vary depending on your specific circumstances. 
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Chapter 14:  
Common Causes of RAID Failure 

 
 

In most cases data is still recoverable in a RAID failure if the user takes immediate actions to 
write-protect the disks. 

Hard Disk Failure 
RAID 0 has no protection against hard disk failure. The failed disk must be physically 
repaired to recover data.  

 
RAID 5 can continue to function in degraded mode after one disk has failed. The user can 
replace the bad disk with a new disk and perform a rebuild to regenerate data on the failed 
disk using parity data on the remaining disks. When the rebuild is complete, the RAID is back 
to normal working order. 

 
The following can go wrong during a rebuild:  

• The user may inadvertently cause the loss of the original RAID configuration. 
• The user may inadvertently initialize the RAID. The initialization may permanently 

write over all data. It usually takes several hours to complete. 
• A good disk may be mistakenly replaced instead of the failed disk.  
• The rebuild may be performed with an incorrect number of disks. For example, a 

RAID may be configured with a “hot spare” which is mistakenly included in the 
rebuild. 

• The rebuild may be interrupted by an external event such as power loss, human 
errors, etc.  

• The rebuild may be performed with the component disks out of the original order.  
• The rebuild may be performed with a different stripe (block) size.  
• A second disk may fail before the rebuild is complete. 

 
Data may still be recovered using our RAID recovery service. See "Chapter 20: RAID 
Recovery Services." 

RAID Controller Failure 
A hardware RAID controller may fail. When the bad controller is replaced by a new 
controller, the original RAID configuration is usually lost. Other events causing further 
complication include the following: 

• A different model of RAID controller is used. 
• The RAID is inadvertently reinitialized. 
• The disks are connected to the new controller in a different order. 
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System Update 
A software RAID may be lost during an upgrade of Windows. 

Incorrect RAID Level 
Sometimes a RAID intended to be level 5 was erroneously configured as a RAID 0. When 
one disk fails and cannot be physically repaired, data is lost because there is no redundancy. 
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Chapter 15:  
Overview of Hardware RAID Reconstruction 

 
 

See “Hardware RAID” in Chapter 13 to determine whether the RAID is hardware- or 
software-based. 

Do You Need to Read This Chapter? 
First determine if the RAID hardware mechanism is still working. Data can be lost due to an 
event unrelated to the RAID mechanism, such as in the following cases: 

• Files are lost by virus attacks or accidental deletion.  
• Volumes are deleted, resized, reformatted or otherwise changed in Windows Disk 

Manager. 
 

In such cases you can follow procedures for ordinary (i.e. non-RAID) drives discussed 
throughout this manual.  

 

The procedures in this chapter are for a failed hardware RAID that is no longer accessible in 
Windows, such as in the following cases: 

• The RAID controller has failed and/or has been replaced and the original logical 
volumes are lost. 

• One or more disks have physically failed. 
• The disks have been physically moved within the controller. For example, the cables 

connecting two disks may have been accidentally swapped. 
• The RAID configuration has been changed in the RAID BIOS or a vendor-supplied 

configuration program. 
 

Making this distinction is important to avoid wasting time and possibly money following 
RAID recovery procedures when the RAID has not failed. 

Rebuild or Reconstruct 
You should understand the difference between rebuilding and reconstructing a RAID. RAID 
rebuilding is a risky and irreversible procedure. You use a utility, usually supplied by the 
RAID controller manufacturer, to restore the RAID to working order by modifying the 
component disks. If a mistake is made or an unexpected error occurs, you may not be able to 
go back to the starting state, and data may be lost permanently. 

 

On the other hand, RAID reconstruction is a safe, read-only and repeatable procedure except 
for normal disk tear and wear. In this procedure, you use File Scavenger® to emulate a RAID 
controller. Data blocks are extracted from the individual component disks, assembled into the 
original data and copied to a new drive. No changes are made to the original disks. If a 
mistake is made or an error occurs, you can repeat the procedure or try other remedies. 

Using Our Services 
Please see “Chapter 20: RAID Recovery Services.” 
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Chapter 16:  
Reconstruction Procedures for Hardware RAID 

 
 

The procedures below are for hardware RAID. See “Hardware RAID” in Chapter 13. 
 

The reconstruction consists of the following steps: 
• Optionally back up the component disks.  
• Reconfigure the component disks as stand-alone disks.  
• Locate a destination folder for recovery. 
• Determine the RAID settings.  
• Reconstruct the RAID and recover data to the destination folder. 

Back Up the Component Disks 
You must weigh the safety of backing up the disks against the additional time and disk space 
resources. If a disk fails, the disk image file created from the disk can be used in its place. 
Note that if you have a RAID 5 with no failed disks, you are already protected from the 
failure of one disk. Creating disk images in that case may be unnecessary. 

Reconfigure the Component Disks as Stand-alone Disks 
The RAID disks must be reconfigured as stand-alone disks for reconstruction. They must be 
concurrently installed on a computer running Windows® 7, Vista, XP, 2008, 2003 or 2000. 
We discuss four methods to do this, as follows: 

• You can connect the disks to ordinary (i.e. non-RAID) disk controllers.  
• Many RAID controllers (e.g., Promise) let you disable RAID functions and thus 

become ordinary controllers. 
• A RAID controller usually lets you configure each disk as a one-disk RAID 0, which 

is equivalent to a stand-alone disk (e.g., Adaptec). 
• If you can mount only one disk at a time, create a disk image of the disks onto a large 

disk (see “Disk Image File” in Chapter 7) and use the disk images for reconstruction. 
 

 
 

Figure 16.1: A working hardware-based RAID 0 volume consisting of  
two 18.68 GB disks is displayed in Windows Disk Manager as a 37.35 GB disk. 
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Figure 16.2: The RAID failed and the disks have been connected  
to the computer as two stand-alone disks for reconstruction. 

Locate a Destination Folder for Recovery 
See “Destination Folder” in Chapter 6. 

Determine the RAID Settings 
See “Chapter 19:  RAID Settings.” 

 
You must know the following: 

• Disk order.  
• Parity rotation if it is a RAID 5. 
• Block size.  
• The First Sector number of the RAID disk area.  

Reconstruct the RAID 

Reconstruct a RAID 5 

• Start File Scavenger. Select Quick Search. Click Advanced.  
• Select Striped Volume, With Parity. Choose the number of disks.  
• Select Hardware-based. Select a parity rotation pattern. Click OK.  
• Select the disks in the correct order. For each disk, specify a First Sector value and 

click Add. Click OK after all disks have been selected.  
• Choose a Block Size and click OK. 
• To recover data you need a Professional-Use license. See “Purchasing a License” In 

Chapter 6. 

Use the Long Search if the Quick Search does not succeed. 
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Reconstruct a RAID 0 

• Start File Scavenger. Select Quick Search. Click Advanced.  
• Select Striped Volume. Choose the number of disks. Select Hardware-based. Click 

OK.  
• Select the disks in the correct order. For each disk, specify a First Sector value and 

click Add. Click OK after all disks have been selected.  
• Choose a Block Size and click OK. 
• To recover data, you need to have a Professional-Use license or a Personal-Use with 

RAID 0 license. See “Purchasing a License” in Chapter 6. 

Use the Long Search if the Quick Search does not succeed. 
 

 
 

Figure 16.3: Reconstruct a RAID 0 with two disks. 
 

 
 

Figure 16.4: Choose the original disks in the correct order. 
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Chapter 17:  
Overview of Software RAID Reconstruction 

 
 

See “Software RAID”  in Chapter 13 to determine whether the RAID is software- or 
hardware-based. 

Do You Need to Read This Chapter? 
First determine if the RAID mechanism has failed. Data can be lost but the RAID has not 
failed, such as in the following cases: 

• Files are lost by virus attacks or accidental deletion.  
• The RAID volume is reformatted but not reconfigured. 

 
In such cases you can follow procedures for ordinary (i.e. non-RAID) drives discussed 
throughout this manual.  

 
The procedures in this chapter are for a failed software RAID, where the RAID volume is no 
longer accessible in Windows, such as in the following cases: 

• One or more disks have physically failed. 
• The RAID volume has been deleted or somehow disappeared. 
• The RAID volume has been redefined in Windows Disk Manager. 

 
Making this distinction is important to avoid wasting time and money following RAID 
recovery procedures when the RAID has not failed. 

Using Our Services 
Please see “Chapter 20: RAID Recovery Services.” 
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Chapter 18:  
Reconstruction Procedures for Software RAID 

 
 

These procedures are for software RAID. See “Software RAID” in Chapter 13. 
 

RAID reconstruction consists of the following steps  
• Optionally backup the component disks.  
• Locate a destination folder for recovery. 
• Determine the RAID settings.  
• Reconstruct the RAID and recover data to the destination drive. 

Back up the Component Disks 
See “Back up the component disks” in Chapter 16. 

Find a Destination Drive for Recovery 
See “Destination Folder” in Chapter 6. 

Determine the RAID Settings 
See “Chapter 17:  RAID Settings” for complete descriptions of RAID settings”. 

 
You must know the following: 

• Disk order.  
• The First Sector number, which is 63 (or 32 for some IBM disks) unless other 

partitions precede the RAID partition.  
 

If the disks are from a NAS (Network-Attached Storage) device that uses a customized 
version of Windows®, you will also need to determine the Block Size, which may not be the 
default value 64 KB for software RAID. 
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Reconstruct the RAID 

Reconstruct RAID 5 

• Start File Scavenger. Select Quick Search. Click Advanced.  
• Select Striped Volume, With Parity. Choose the number of disks.  
• Select Software-based. Select either the Windows® NT or Windows® 

2000/2003/Vista parity rotation. Click OK.  
• Select the disks in the correct order. For each disk, specify the First Sector value. 

Click Add. Click OK after all disks have been selected.  
• Choose the Block Size of 64 KB and click OK.  
• To recover files, you need a Professional-Use license. See “Purchasing a License” in 

Chapter 6. 

Use the Long Search if the Quick Search does not succeed. 

Reconstruct RAID 0 

• Start File Scavenger. Select Quick Search. Click Advanced.  
• Select Striped Volume. Choose the number of disks.  
• Select Software-based. Click OK.  
• Select the disks in the correct order. For each disk, specify the First Sector value and 

click Add. Click OK after all disks have been selected.  
• Choose the Block Size of 64 KB and click OK.  
• To recover files you need a Professional-Use license or a Personal Use license with 

RAID 0. See “Purchasing a License” in Chapter 6. 

Use the Long Search if the Quick Search does not succeed.  
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Chapter 19:  
RAID Settings 

 
 

Successful RAID reconstruction requires knowing the RAID settings. Using incorrect settings 
will result in recovered files that are corrupt and can not be opened in their respective 
program. For a simple configuration such as a two-disk RAID 0 or three-disk software RAID 
5, the number of possible combinations is manageable. For a complex case such as a seven-
disk hardware RAID, it may be impractical to perform the reconstruction yourself. See “Do It 
Yourself or Use Our Services” in Chapter 13. 

 
RAID settings can always be determined with certainty using our fee-based RAID recovery 
service. See “Chapter 20: RAID Recovery Services.” 

RAID Level 
File Scavenger® can reconstruct RAID levels 0 (striped volume) and 5. A RAID level 1 does 
not need reconstruction because it consists of two disks containing identical data. Files can be 
recovered from either disk.  

 
Check the box With Parity if the RAID level is RAID 5. Clear it if it is RAID 0. 

RAID Implementation 
RAID can be implemented in software or hardware. See “Chapter 11: Overview of RAID 
Reconstruction.” 
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Figure 19.1: RAID implementation and parity. 

RAID 5 Parity Rotation 
In a RAID 5, parity data is generated to protect data against the failure of one disk. The parity 
data is distributed evenly among all component disks in a rotating pattern.  

Forward 
This rotation is used on software RAID created on a Windows® NT computer. This 
rotation is also observed on older controllers. 

 
Warning: This statement is a general guideline. The RAID 5 parity rotation used by a 
particular manufacturer is subject to change without notice.  

Backward 
This rotation is used by the Dell MegaRAID® and the HP (formerly Compaq) controllers 
as well as most newer controllers. 

Backward, symmetric 
This rotation is used on software RAID 5 created on Windows® 7, Vista, XP, 2008, 
2003, 2000 and a few RAID controllers. This rotation pattern balances the I/O load 
equally on all component disks. 

Disk Order 
File Scavenger® will ask you to enumerate the component disks in their order in the RAID. 
For hardware RAID, the order almost always follows the increasing disk number (for 
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example, SCSI numbers 1, 2, 3, etc.). If the disks are no longer in their original position, you 
must try all possible combinations. There are two possible combinations for two disks, six for 
three disks, 24 for four disks, 120 for five disks, etc. When there are too many combinations 
to try, you may consider using our RAID recovery service. See “Chapter 20: RAID Recovery 
Services.” 

 

 
 

Figure 19.2: The disk order for this RAID is 1, 2 and 3. 
 

For software RAID, the order may not follow the disk numbers. You must try all 
combinations or use our RAID recovery service. See “Chapter 20: RAID Recovery Services.” 

Stripe (Block) Size 
Software RAID always uses a block size of 64 kilobytes. (NAS devices running customized 
versions of Windows® may use a different size.) About 75% to 80% of hardware RAIDs also 
use 64 KB as the default unless overridden by the user during RAID setup. Other popular 
block sizes are 1024 KB, 128 KB, 32 KB, 16 KB and 8 KB. If the block size is not known, 
consider using our RAID recovery service. See “Chapter 20: RAID Recovery Services.” 

 

 
 
 
 

Figure 19.3: Block Size. 
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First Sector Value for Hardware RAID 
About 75% of RAID controllers use all disk sectors for storing data, starting at sector 0. For 
those controllers, the First Sector value is 0. However, some controllers reserve an area at the 
beginning of the disks to store configuration information. Their First Sector value is the size 
of this area. This value varies among manufacturers and, within the same manufacturer, 
among specific controller models. Some special values we have encountered are the 
following:  

• 0 for the first disk and 10 for the remaining disks (e.g., HighPoint, Rocket 100)  
• 1024 for all disks (e.g., 3Ware) 

First Sector Value for Software RAID 
In software RAID, the first track of a component disk contains the master boot record and is 
not part of the RAID. A track usually contains 63 sectors (except for some IBM disks with 32 
sectors). Data is stored starting at sector 63 (or 32 for IBM disks). 
 
If a disk is wholly allocated to a RAID, the First Sector value for reconstruction is this value. 
This is also true for mixed-use disks where the first disk extent (an extent is very similar to a 
partition) is allocated to the RAID. See Figure 19.4. 
 
Calculating this value is difficult for disks with other extents preceding the RAID extent. To 
determine the starting sector of the RAID disk area, you must use a disk utility such as 
dmdiag, available from Microsoft®. In Figure 19.4, the First Sector value for Disk 3 
(assuming this is not an IBM disk) is 63. The First Sector value for Disk 2 is 63 plus the size 
of volume E (in sectors) and possibly a small gap of a few (0 to 7) unused sectors between the 
first and second partition. 

 

 
 

Figure 19.4: A software RAID 0 (drive D) configured on mixed-use disks.  
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Chapter 20: 
RAID Recovery Services 

 
 

Successful RAID recovery requires knowing the RAID settings (see “Chapter 17: RAID 
Settings.”).  If they are not known, you may need our RAID recovery service. This service is 
offered at four levels:  

• Remote assistance: We remotely determine the RAID settings and send you step-by-
step recovery instructions. (Low fees) 

• Remote recovery: We remotely log on to your computer to recover data for you.  
(Low fees)  

• Offsite recovery: You send us the disks for recovery.  (Higher fees) 
• Onsite dispatch recovery: We come to your location. Availability depends on your 

geographic location and our staff availability.  (Highest fees) 
 
All fees are fully refunded if data is not recovered with the exception of travel expenses for 
onsite dispatch. 
 
The following tables compare the costs and times for recovering a RAID 5 with four disks: 

 
 Cost Calendar 

time 
Your labor Success 

rate 
Do-it-yourself $185 3 days 48 hours 25% 
Remote assistance $800 1 day 8 hours 95% 
Remote recovery $800 1 day 2 hours 95% 
Offsite recovery $1,600 2-3 days 1 hour 95% 
Onsite dispatch Call us 1-2 days 1 hour 95% 

 

Table 20.1: Service levels for RAID 5 recovery. 
 

The following tables compare the costs and times for recovering a two-disk hardware RAID 
0: 

 
 Cost Calendar 

time 
Your labor Success 

rate 
Do-it-yourself $89 1 day 16 hours 80% 
Remote assistance $450 1 day 8 hours 95% 
Remote recovery $450 1 day 2 hours 95% 
Offsite recovery $900 2-3 days 1 hour 95% 
Onsite dispatch Call us 1-2 days 1 hour 95% 

 
Table 20.2: Service levels for RAID 0 recovery. 
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Data Recovery Evaluation Form 
You can get started by filling out the data recovery evaluation form.  
http://www.quetek.com/cgi-bin/evalform 

 
This form is for us to determine if data is recoverable and get your contact information.  

Remote Assistance 
With this service you will perform reconstruction following our step-by-step instructions. 
This service is reasonably priced and takes the least time. It requires a computer technician on 
your staff with at least one year of experience with computer hardware and Windows® 
installation. 

 
The process starts with your submission of the data recovery evaluation form. If data is 
determined to be recoverable we will send you further instructions that basically consist of the 
following steps: 

 
• Reconfigure the disks as standalone disks. See “Reconfigure the component disks as 

stand-alone disks” in Chapter 16. 
• Follow our request to run a trace, which extracts critical information on the disks and 

writes it to a file. The file can then be zipped and uploaded to our web site. This 
process usually takes about 30 minutes to a few hours, depending on data contents, 
disk size and speed and processor speed. 

• We then analyze the trace to determine the correct procedures to reconstruct the 
RAID. We will request payment once data is determined to be recoverable. 

• Send payment and follow our step-by-step recovery procedure. 
 

This process usually takes a day. Historically the success rate has been about 90% to 95%. 
The 5% to 10% failure rate is due to data contents on disk having been corrupted beyond 
recovery. 

Remote Recovery 
With this service, we remotely log on to your computer via UltraVNC.  We then perform 
RAID reconstruction and recover data for you. This service is as fast as remote assistance and 
requires less of your time. 

 
The process starts with your submission of the data recovery evaluation form. If data is 
determined to be recoverable, we will send you further instructions that basically consist of 
the following steps: 

• Set up a recovery computer running Windows 7, Vista or XP. 
• Install the disks on the recovery computer as standalone disks. See “Reconfigure the 

component disks as stand-alone disks” in Chapter 16. 
• Prepare a destination folder for recovery. 
• Sign and submit a waiver from. 

http://www.quetek.com/waiver.htm 
 

• We will set up a time to log on to the recovery server, reconstruct the RAID and 
recover data to the destination folder. 

http://www.quetek.com/cgi-bin/evalform�
http://www.quetek.com/waiver.htm�
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Running UltraVNC 
After submitting the waiver form, you will be offered to download the UltraVNC 
program. 

 
 

 
 

Figure 20.1: Download UltraVNC. 
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Please download the program appropriate for your version of Windows.  Run it and select 
to connect to Host1 or otherwise instructed by our technician. 

 

 
 

Figure 20.2: Select a host to initiate a connection. 
 
 

The recovery computer will be controlled remotely by our technician.   
 
Note: On Windows 7 and Vista, you may need to double click on the UltraVNC icon on 
the taskbar to bring up the Initiate Connection dialog. 

 

 
 

Figure 20.5: Connect to the VNC client (i.e., us). 
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Offsite Recovery 
Under this service, you will send us the disks. The process starts with your submission of the 
data recovery evaluation form. If data is determined to be recoverable, we will send you 
further instructions that basically consist of the following steps: 

• Sign a waiver and fax it to us. 
http://www.quetek.com/waiver.txt 

• Send us a purchase order or service request. 
• Pack and ship the disks. 

 
http://www.quetek.com/drive_packing.htm 

Onsite Dispatch 
Under this service, we will send an expert to your location. Availability depends on where 
you are and our staff schedule. The process starts with your submission of the data recovery 
evaluation form. If data is determined to be recoverable, we will send you further instructions 
that basically consist of the following steps: 

• Sign a waiver and fax it to us. 
http://www.quetek.com/waiver.txt 

• Send us a purchase order or service request 
• Send us payment for travel expenses and an evaluation fee. These are non-refundable 

regardless of the outcome. 
 

This service is priced on an individual basis but will cost many times more than the other 
services.  

http://www.quetek.com/waiver.txt�
http://www.quetek.com/waiver.txt�
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Chapter 21: 
Overview of Spanned Volume Reconstruction 

 
 

What Is a Spanned Volume? 
A spanned volume is a concatenation of disk segments to form what appears as one logical 
volume. This can be best explained in the example below, where drive D starts out as a 
simple volume with 114.5 GB. 

 

 
 

Figure 21.1: Volume D with the initial size of 114.50 GB. 
 
 

When drive D runs out of space, it can be extended by concatenating disk 3 to it. 
 

 
 

Figure 21.2: Right-click on volume D and choose to extend it. 
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Figure 21.3: Extend Volume Wizard. 
 

 
 

Figure 21.4:  Add Disk 3 to form a spanned volume. 
 
 



 

User Guide - 113

Drive D now becomes a spanned volume 
 

 
 

Figure 21.5: Volume D spans Disks 1 and 3. 
 

The size of D is the total size of the two disks. 
 

 
 

Figure 21.6: Properties of volume D. 
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A spanned volume implemented in hardware is called a JBOD (just a bunch of disks). It is 
displayed in Windows Disk Manager as one physical disk because the hardware performs the 
concatenation transparently to Windows®. 

Do You Need to Read This Chapter? 
If the spanned volume mechanism is intact and data loss was due to other causes such as 
accidental deletion, you do not need to read this chapter. Treat the volume as an ordinary 
volume. 

 
If the spanned volume has failed, it needs to be reconstructed. In the figure below, drive D in 
the example above has failed, and the disks are now displayed as Unallocated. 

 

 
 

Figure 21.7: A failed spanned volume. 

Using Our Services 
Please see “Chapter 20: RAID Recovery Services.”  
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Chapter 22: 
Spanned Volume Reconstruction Procedure 

 
 

The procedures discussed in this chapter are for software-based spanned volumes. Hardware-
based spanned volumes (JBODs) are rarely encountered and will be briefly discussed at the 
end of the chapter. 

Disk Extent First and Last Sector 
Successful recovery depends on knowing the first and last sectors of each disk extent. To 
explain this, we use a hypothetical example below. 

 
Assume there is a software-based spanned volume consisting of two disks. The disks are of 
identical size of 1,000,000 sectors each. The disks form a spanned volume. The total size will 
be less than 2,000,000 sectors because the first track (sectors 0 to 62) is reserved for the 
Master Boot Record. On Windows® 2000 or later, the last 2,048 sectors (997,952 to 999,999) 
are also reserved for dynamic disk configuration. 

 
In computer science, addresses are usually zero-based. A drive with 1,000,000 sectors 
contains sectors 0 to 999,999.  

 
The spanned volume will contain 1995778 sectors as follows: 

 
Spanned volume logical sectors Mapped to physical sectors 
0 to 997888 63 to 997951 on disk 1 
1997889 to 1995777 63 to 997951 on disk 2 

 
The reconstruction process requires specifying two disk extents: 

• Extent 1: Sectors 63 to 997951 on disk 1 
• Extent 2: Sectors 63 to 997951 on disk 2 

 
If the first sector of extent 1 is incorrectly specified (for example, as sector 0), data can still be 
recovered because File Scavenger® can detect and compensate for this error. If the last sector 
of extent 1 or the first sector of extent 2 is incorrect, all sectors on disk 2 will have incorrect 
offsets and only data on disk 1 will be recovered. The last sector of disk 2 can be incorrect 
without much effect on the recovery. 

 
The accurate size of a disk can be determined by the following: 

• Select the disk in the File Scavenger® Look In box. Make sure to select the disk 
number (such as Disk 1), not the drive letter (such as D). 

• Click File, Disk Image, Create. The value in the To Sector field is the last sector 
number. This value plus one is the size of the disk. 
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Figure 22.1: The disk size is 39,856,320 sectors. 

Recovery Procedure for Software-based Spanned Volume 
 

Spanned volume reconstruction consists of the following steps: 
• Optionally back up the component disks.  
• Locate a destination folder for recovery. 
• Determine the spanned volume configuration.  
• Reconstruct the spanned volume and recover data to the destination folder. 

Back Up the Component Disks 
See “Back up the component disks” in Chapter 16. 

Find a Destination Drive for Recovery 
See “Destination Folder” in Chapter 6. 

Determine the Configuration of the Spanned Volume 
You must know the following: 

• The number of extents and their order.  
• The first and last sector numbers of each extent. See the discussion at the beginning of this 

chapter. 

Reconstruct the Spanned Volume 
This section is applicable when the entire disks are used in the spanned volume. If the disks 
contain other partitions, please see the next section. 

 
• Start File Scavenger. Select Quick Search. Click Advanced. 
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• Select Spanned Volume and click OK. 

 

 
 

Figure 22.2: Spanned volume reconstruction. 
 

• Select the disk extents in the correct order. Specify the first and last sectors as 
discussed at the beginning of this chapter. 

 

 
 

Figure 22.3: Volume extents. 



  

 
User Guide - 118 

 

Disks with Other Partitions 
Consider the spanned volume K: in the figure below: 

 

 
 

Figure 22.4: A spanned volume on disks with other partitions. 
 

If this volume fails and needs to be reconstructed, the first sector numbers of the extents are 
not easy to compute. You may need to use the Microsoft® dmdiag utility or use our recover 
services. See “Chapter 20: RAID Recovery Services.”  
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Hardware-based Spanned Volume 
The recovery procedure is similar with the following differences: 

• The first sector for a disk extent is not the track size (63) but is hardware-dependent. 
See “First Sector value for hardware RAID” in Chapter 17. 

The last sector for a disk extent is usually the last sector of the disk.  
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Appendix A: 
Contact & Technical Support 

 
 

Contact Information 
 

QueTek® Consulting Corporation 
2650 Fountain View, Suite 122 
Houston, Texas 77057 
United States of America 
 
Telephone numbers for sales and first-level Technical Support: 

• International customer: +1 713 722 0584 
• Houston area: 713 722 0584 
• U.S. and Canada toll-free: 866 722 0584 
• Fax: +1 832 251 8037 

Email:  
• Sales: sales@quetek.com 
• Second- and third-level Technical Support: help@quetek.com 

 
Technical questions sent via email are directly routed to the second and third-level support, 
thus providing the most effective and quickest channel for solving non-trivial technical issues. 
For simple technical questions or sales questions, please call our phone numbers to reach 
first-level support. 

Business Hours  

Our business hours are from 8 AM to 5 PM, U.S. Central Time, Monday through Friday, 
except for the following holidays: 

• New Year's Day.  
• Easter.  
• Memorial Day (last Monday in May) 
• July 4th.  
• Labor Day (first Monday in September).  
• Thanksgiving (fourth Thursday in November).  
• Day after Thanksgiving.  
• Christmas Eve.  
• Christmas Day.  

mailto:sale@quetek.com�
mailto:help@quetek.com�
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If a holiday falls on a Saturday or Sunday, it will be observed on the preceding Friday or 
following Monday, respectively.  

U.S. Central Time is five hours behind GMT during Daylight Saving Time from April to 
October and six hours behind GMT from October to April. 

We answer emails from 6 AM to 10 PM on business days. Most emails are answered within 
one hour. All are answered within 24 hours or less. Please type a clear subject heading to 
avoid your message being inadvertently flagged as “junk” and deleted. 
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